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Varian offices

Varian has offices in most countries. The major offices for optical
spectroscopy products are listed below:

Varian Australia Pty Ltd (Manufacturing site)
679 Springvale Road
Mulgrave, Victoria 3170
Australia
International telephone: + 61 3 9560 7133
International fax: + 61 3 9560 7950

Varian Instruments
2700 Mitchell Dr
Walnut Creek, CA 94598
Telephone: 1 800 926 3000
International telephone: +1.925.939.2400
International fax: +1.925.945.2102

Varian Chrompack Benelux Analytical Instruments
Boerhaaveplein 7, 4624 VT Bergen op Zoom
Postbus 250, 4600 AG Bergen op Zoom, Netherlands
International telephone: +31 0164 282800
International fax: +31 0164 282828

Internet

The Varian Internet home page can be found at:
http://www.varianinc.com

Varian Australia Pty Ltd is the owner of copyright on this document
and any associated software. Under law, the written permission of
Varian Australia Pty Ltd must be obtained before either the
documentation or the software is copied, reproduced, translated or
converted to electronic or other machine-readable form, in whole,
or in part.

First published October 1997 in Australia. Modified in Jan 1999
and May 1999. Comments about this manual should be directed to
the Marketing Communications Manager, Varian Australia at the
address above or email uv@osi.varian.com.

Varian Australia is ISO9001 certified.

© 1997 Varian Australia Pty Ltd  (A.C.N. 004 559 540). All rights
reserved.
® Windows 95, 98 and NT are registered trademarks of Microsoft
Corp.
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1 Introduction

The Cary 50/100/300/400/500 instruments run under Varian's
easy-to-use Cary WinUV software. Depending on the type of
system ordered, the software will consist of some or all of the
following applications:

ADL Shell A pre-defined template for writing ADL
programs

Advanced Reads Used to collect absorbance readings for
multiple samples

Align Used to align various lamps and
accessories in the instrument

Concentration Used for quantitative analysis

Dissolution Used to perform tablet dissolution
measurements (Cary 50/100/300 only)

Enzyme Kinetics Used to determine various parameters of
enzyme activity

Fabric Protection Used to test solar radiation transmission
through unstretched dry textiles

GLP Administration Used to restrict operator access, password
protecting each application

Kinetics Used to perform kinetics determinations

RNA/DNA Used to collect absorbance readings of
nucleic acids

Scan Used to run and view data collections

Scanning Kinetics Used to perform kinetics determinations for
a wavelength range

Simple Reads Used to collect single wavelength
absorbance readings

Sunglasses Used to determine penetration of solar UV
radiation through sunglasses and sunglare
filters
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System Information Used to enter system information, such as
company and instrument details

Thermal Used to perform Thermal DNA analysis
(Cary 100/300/400/500 only)

Validate Used to verify the system's performance.

These applications are discussed further in chapter 3.

� The Cary WinUV software runs under the Microsoft Windows®
95, Windows 98 or Windows NT operating systems.

1.1 Cary documentation
You have been provided with the following documentation to help
you set up and operate your Cary system:

� Cary hardware manual, with Safety practices and hazards
information, instructions for installing and maintaining various
hardware components, and hardware-related troubleshooting
information

� This software manual, with instructions for installing the Cary
WinUV software, an overview of the software and software-
related troubleshooting information

� Extensive online Help (provided with the Cary WinUV software)
containing context-sensitive Help, step-by-step instructions for
frequently performed analyses and instructions for using
various accessories. Refer to section 3.3 for details on using
the online Help.

Conventions

The following conventions have been used throughout this manual:

� Italics indicate menu items, menu options and field names (e.g.
select Copy from the Edit menu).

� Keyboard and mouse commands have been typed in bold
(e.g. press the F1 key).

� Double quotes (" ") are used to signify the buttons appearing
throughout the software (e.g. select "OK").

� ALL CAPITALS indicate text you must type in from the
keyboard (e.g. type SETUP at the prompt).
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2 Software installation

This chapter assumes you have already set up the instrument and
PC, including installing the instrument interface card in the PC (if
you supplied your own PC) and connecting the instrument and/or
PC to the power supply as described in the appropriate Cary
hardware documentation.

2.1 PC requirements

2.1.1 Minimum computer requirements
The minimum configuration represents the absolute minimum you
can run the software on. This PC configuration may be out of
manufacture, but you may want use a PC you already have. The
recommended configuration is that which you would buy new.

Minimum Recommended
IBM compatible IBM compatible
Intel Pentium processor Intel Pentium II processor
16 M RAM 64 M RAM
150 MB free space on
hard disk

500 MB free space on
hard disk

Video card supporting
800 x 600 resolution,
high color (16 bit) mode

Video card supporting
800 x 600 resolution,
high color (16 bit) mode

Super VGA screen Super VGA screen
4 x CDROM drive 10 x CDROM drive
16 bit sound card 16 bit sound card
Windows 101 key
keyboard

Windows 101 key
keyboard

Continued…
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Minimum Recommended
Microsoft or compatible
mouse

Microsoft or compatible
mouse

One spare AT bus 16 bit
ISA expansion slot

One spare AT bus 16 bit
ISA expansion slot

Microsoft Windows 95®,
Windows 98® or Windows
NT® (including service
pack 4 or later)

Microsoft Windows 95®,
Windows 98® or Windows
NT® (including service
pack 4 or later)

Microsoft Internet
Explorer*4 or later if using
Windows 95 or NT

Microsoft Internet Explorer
*4 or later if using
Windows 95 or NT

Cary 50 only Cary 50 only
1 Spare PC power supply
connector

1 Spare PC power supply
connector

Power Supply rating 220
Watts.

Power Supply rating 220
Watts.

1 Spare Slot for the
accessory cable connector

1 Spare Slot for the
accessory cable connector

*The Cary WinUV software uses functionality provided by
Microsoft’s Internet Explorer 4.0 (IE4). You do not need to use IE4
as your web browser. If your company’s rules prevent the
installation of IE4 you can use another browser, with some loss in
functionality (Refer to section 2.5.).

2.1.2 Why do I need Internet Explorer 4?
In order to use all the features of the online Help, you should have
Microsoft Internet Explorer 4.0 installed on your PC. The unique
features include:

� an expandable hierarchy of all Help contents;

� a search facility to display a list of topics containing specific
key words;

� the ability to find words within a displayed topic;

� an editable ‘Favorites’ tab to list those Help pages that you
would like to easily redisplay;

� instructional videos to visually demonstrate selected
procedures.

You do not need to be connected to the Internet and you do not
need to use IE4 as your browser. The Cary WinUV instrument
software also uses some of the functionality provided by IE4.
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You can download a free copy of IE4 from Microsoft’s website at
www.microsoft.com. Make sure that you download the correct
language version for your version of Windows. If you are not
connected to the Internet you can purchase IE4 on CDROM from
your local software supplier.

Refer to section 3.3 for more information on using the special
features of the online Help.

2.2 Upgrading from version 1
If you have received an upgrade package then you can follow the
instructions in section 2.3 to install the software. Note the following
points:

� Install version 2 of the WinUV software into the same directory
as you installed version 1 to replace version 1 of the software.
Your data files will be kept as they are and can be used with
version 2.

� The upgrade packages include three Help & Videos CDs.
Select the one appropriate for your instrument. You can
discard the other two if you wish.

2.3 Installing the software
Use the following checklist to install the Cary WinUV version 2
software.

A Windows operating system is
installed and all devices e.g.
sound card, CDROM are working.

Refer to the
documentation
supplied with your
Windows software.

Internet Explorer 4 or later has
been installed.

Refer to the
documentation
supplied with Internet
Explorer.

You have set your PC screen
desktop area to at least 800 x 600
and have set the color palette to
at least High color.

Refer to section 2.3.3

You have installed the instrument
interface card in the PC and
connected the PC to the Cary
instrument

Refer to the Hardware
manual supplied with
the instrument.

Continued…
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You have logged on as an
Administrator if you are running
Windows NT.

Refer to the
documentation
supplied with NT.

You have installed the Cary
software and the Help (2nd CD).

Refer to 2.3.1

You have re-booted the PC. Refer to your Windows
documentation.

✒ Note The Cary WinUV software will read Cary OS/2 and DOS data files,
if you have any.

2.3.1 Installing the Cary WinUV software:

1. Turn on your PC.

✒ Note If you are running Windows NT, logon as an Administrator or as a
user with Administrator privileges.

2. Insert the Cary WinUV CD into the CD-ROM drive.

3. Select the "Install Cary Software" button in the window that
appears.

4. Follow the instructions appearing on the screen. During the
installation you will be asked to specify, amongst other things,
the drive on which to install the software.

✒ Note If you are installing a Solascreen package you will be asked if you
want to copy videos for the Fabric and Sunglasses wizards to your
hard disk. If you want to use either of these programs in their
simplest mode the majority of the time then select ‘Yes’. You will
also be asked what type of interface and which Standards you
want to install for the Fabric and Sunglasses applications. If you do
not know what to select here then choose the Advanced interface
and All Standards. You can change this later by referring to the
online Help (search for fpchoice.exe if you are using the Fabric
Protection application or sgchoice.exe for the Sunglass
application).

When the installation is complete you should have a Cary Program
group on the desktop containing a number of icons. The installation
also places a Cary WinUV folder in the Start/Programs menu.
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✒ Note If you are running Windows NT and did not have Administrator
privileges, the installation will fail. To successfully complete the
installation, re-logon as an Administrator start the installation
process again.

5. Remove the Cary WinUV CD from the CD-ROM drive and
insert the Cary Help and Videos CD, as prompted.

✒ Note You will need to insert the Cary Help and Videos CD into the CD-
ROM drive each time you want to view videos included in the Help.

6. Follow the instructions appearing on the screen. You will be
prompted to insert the Patches CDROM after the Help
installation.You will need to restart Windows after the
installation is finished. You can leave the Help & Videos CD in
the drive if you like.

✒ Note Patches are files designed to fix known software problems. When
you insert the Patches CDROM it will autostart and you can then
follow the instructions on the screen to install the patches.

✒ Note If it has never been run before, the System Information application
will appear maximized when Windows is restarted, prompting you
to enter such information as the company details you would like to
appear in reports and hint text properties. Otherwise, it will be
minimized on the Windows taskbar.

2.3.2 Late breaking news
Before proceeding further you should read the Late breaking news
documents supplied with the software. The documents contain the
latest release information and important notes.

2.3.3 Changing the monitor resolution
For optimum viewing, your monitor resolution should be set to 800
x 600 pixels (or greater) and High colour (16 bit) (or greater).

To set the monitor resolution:

1. Click on the Windows "Start" button.

2. Point to Settings and select Control Panel from the flyout
menu.

3. Double click on the Display icon.
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4. From the Display Properties dialog, select the Settings tab.

5. In the Desktop area section, drag the sliding bar so that the
pixel amount is set to "800 by 600 pixels".

6. In the Color palette section select High color (16 bit).

7. Select “OK”. At the prompt, which informs you that your
settings will be adjusted, select “OK” again. When asked if you
wish to keep the setting, select “Yes”.

8. You can then exit the Control Panel.

2.4 Starting the Cary software
To start the Cary WinUV software:

1. Click on the Windows "Start" button.

2. Point to Programs and select Cary WinUV from the flyout
menu.

3. Select the desired application from the second flyout menu.

After the initial Cary flash screen appears, the selected application
will open (refer to Chapter 3 for more information on the available
applications).

2.5 Using the online Help
Your Cary software comes equipped with a comprehensive online
Help system. The Help features explanations of each application
including detailed step-by-step instructions on using the software.
The Help also includes 'Tips and Tricks', 'Troubleshooting' and
'Contacts' sections in case you encounter difficulties using the
software.

You can access the Help in a number of ways. You can:

� select the first item from the Help menu in an application or
information about using that particular application.

� Select Help topics from the Help menu in an application to get
to the Home page of the Help.

� Press the F1 key for information about a dialog.

� Select Start, Programs, Cary WinUV, Cary Help to get to the
Home page of the online Help.



Cary WinUV

2-7

2.5.1 Using Netscape Navigator instead of
Internet Explorer

If, for some reason, you cannot load Internet Explorer, you can use
Netscape Navigator as an alternative. The limitation with this is that
Netscape does not support the unique online Help features
outlined in section 2.1.2. Instead, you can only view the raw HTML
files supplied on the Cary Help and Videos CD with little
navigational ability.

If you install Internet Explorer to use the Help but would like
Netscape to be your default browser, just select Default Browser
On, when prompted.

In the later versions of Communicator, you will not be prompted to
select Netscape as your default browser—you must re-enable this
check. To do so, you must look in the directory:

C:\Program Files\Netscape\Users\XXX

at the prefs.js file for the user.

The relevant configuration is:

user_pref("browser.wfe.ignore_def_check", VALUE);

Valid VALUEs are: True (never check) and False (always check).

The configuration to determine if Internet Explorer checks to see if
it should be the default browser is located in the Registry:

\HKEY_CURRENT_USER\SOFTWARE\Microsoft\Internet
Explorer\Main\Check Associations

Valid values are "NO" (never check) and "Yes" (always check).
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3 Software overview

This chapter provides a brief introduction to the Cary WinUV
software to help you familiarize yourself with its use. For more
detailed information refer to the extensive online Help (see section
3.3 for instructions on using the Help).

3.1 Cary applications

The Cary WinUV software is made up of several different
applications, depending on the Cary package ordered:

Package Applications

SCAN ADL Shell, Align, Simple Reads, GLP Administration,
Validate, System Information, Scan with Maths and
Advanced Reads

CONC ADL Shell, Align, Simple Reads, GLP Administration,
Validate, System Information, Scan with Maths plus
Concentration and Advanced Reads

BIO ADL Shell, Align, Simple Reads, GLP Administration,
Validate, System Information, Scan with Maths,
Concentration, Thermal*, Kinetics, Scanning Kinetics,
Enzyme Kinetics, RNA/DNA and Advanced Reads

TABLET# ADL Shell, Align, Simple Reads, GLP Administration,
Validate, System Information, Scan with Maths,
Concentration plus Dissolution and Advanced Reads

SOLASCREEN# ADL Shell, Align, Simple Reads, GLP Administration,
Validate, System Information, Scan, Maths,
Advanced Reads, Fabric Protection and Sunglasses

#Not available for the Cary 400 or 500

* Not available for the Cary 50
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3.1.1 ADL Shell
The Applications Development Language (ADL) is a built-in
spectroscopy language supplied with the WinUV software. The
ADL Shell gives you a pre-defined template for writing ADL
programs. Rather than needing to write the code for basic
functions such as graphing and filing, the ADL Shell has a number
of these commands already implemented. In other words, you do
not have to design your own interface—you can use the ADL Shell
to provide the basic functionality and build on that.

Refer to the online Help (see section 3.3) for a description of the
settings in the ADL Shell application.

3.1.2 Advanced Reads
The Advanced Reads application can be used to read multiple
samples in a single run. You can use various accessories to take
multiple sample solution and aliquot readings, in absorbance,
percent transmittance, Abs*F or percent reflectance mode, and find
the mean.

Refer to the online Help (see section 3.3) for a description of the
settings in the Advanced Reads application.

3.1.3 Align
The Align application is used to align the lamp(s) in the instrument
and various optical accessories such as the Fibre Optic Coupler. It
enables you to set instrument parameters such as the beam mode
and wavelength. It also allows you to keep track of operating hours
by lamp type.

Starting the Align application brings up the Lamps tab of the
Alignment window, which contains a Current Signal bar
representing the energy of the lamp(s). To change the instrument
parameters, select the Cary tab.

Refer to the online Help (see section 3.3) for a description of the
settings in the Align application.

3.1.4 Concentration
The Concentration application is used to calibrate the system for
quantitative analysis. You can select from several fit types for your
calibration: linear, direct linear and quadratic. Based on the fit type
selected, the Concentration application will calculate the
coefficients of the fit equation and the correlation coefficient.
Alternatively, you can define your own equation for the calibration.
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Starting this application brings up the Concentration window. To
set the instrument parameters, define the standards to be used
and configure sampler accessories, select Setup from the menu.
This will bring up the Setup window.

Refer to the online Help (see section 3.3) for a description of the
settings in the Concentration application.

3.1.5 Dissolution (not available for Cary 400/500)
The Dissolution application is used to monitor tablet dissolution,
using up to 2 dissolution baths. The application enables you to
collect data for up to 10 000 minutes (8 days) at defined time
intervals.

The data can be displayed as absorbance, percent dissolved
versus time or milligrams dissolved versus time. You can then
calculate the time taken to reach a series of nominated percent
dissolved values and/or calculate the percent dissolution of the
tablets at given times.

Starting this application brings up the Dissolution window. To set
the instrument and bath parameters, standards and test limits, click
on the “Setup” button or select Setup from the menu.

Refer to the online Help (see section 3.3) for a description of the
settings in the Dissolution application.

3.1.6 Enzyme Kinetics
The Enzyme Kinetics application uses Michaelis-Menten principles
to calculate the maximum rate (Vmax) and substrate concentration
that gives half the maximum rate (Km) of enzyme-catalyzed
reactions.

Accurately obtaining Vmax and Km, requires you to perform
numerous Enzyme Kinetics runs at different substrate or inhibitor
concentrations to create a series of absorbance versus time
curves. The software determines the initial velocity (V0) of each
curve, then you enter the substrate and inhibitor concentrations for
each cuvette.

The software uses the V0, [S] and [I] values to plot traces
representing absorbance versus time curves with a common [S] or
[I]. It is from these graphs that the software determines Vmax and Km.

Refer to the online Help (see section 3.3) for a description of the
settings in the Enzyme Kinetics application.
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3.1.7 Fabric Protection
The Cary Fabric Protection Measurement system is designed to
test the transmission of solar radiation (UVR) in the range of
280–400 nm (UVR) through unstretched dry textiles. The results
obtained indicate the level of protection offered by fabric when
worn in close proximity to the skin. Fabric that is not worn in close
proximity to the skin may provide less UVR protection than
indicated by the test due to UVR back scattering.

Refer to the online Help (see section 3.3) for a description of the
settings in the Fabric Protection application.

3.1.8 GLP Administration
The GLP Administration application is used to protect the system
from unauthorized use, enabling application-specific privileges to
be turned on or off by the system administrator.

If this application is operational, users will need to be registered,
have a user name and a valid password before they can access
the various privileges.

Refer to the online Help (see section 3.3) for a description of the
settings in the GLP Administration application.

3.1.9 Kinetics
The Kinetics application is used to obtain absorbance versus time
data to enable you to determine the rate of reaction.

The Kinetics application allows:

❑ Calculation of Zero order, First order and Second order
reaction rates from absorbance versus time data

❑ Entry of activity factors for multiple cells

❑ Overlay of the best-fit line on raw data

❑ Auto or manual estimates for the first order and second order
Marquardt fitting.

Refer to the online Help (see section 3.3) for a description of the
settings in the Kinetics application.
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3.1.10 RNA/DNA
The RNA-DNA application is used to calculate the following
parameters, used in determining the amount, type and purity of
nucleic acid samples:

❑ Absorbance of samples at selected wavelengths;

❑ A(260)/A(280) ratios with or without background correction at
320 nm;

❑ Absorbance ratios at your own nominated wavelengths with
or without background correction;

❑ Average ratio values for replicate samples;

❑ Protein and nucleic acid concentrations using Warbug and
Christian coefficients; and,

❑ A(260) * F.

Refer to the online Help (see section 3.3) for a description of the
settings in the RNA/DNA application.

3.1.11 Scan
The Scan application enables you to set up and run wavelength
scans, with the collected scans displayed in the Scan window.

To configure the instrument and accessories, measurement mode,
report settings and storage options, click on the “Setup” button or
select Setup from the menu.

Refer to the online Help (see section 3.3) for a description of the
settings in the Scan application.

3.1.12 Scanning Kinetics
The Scanning Kinetics application allows you to perform cyclic
scans across a wavelength or wavenumber range. From the
resultant absorbance versus wavelength data, an absorbance
versus time (kinetics) curve can be obtained for any wavelength in
the range. The kinetics curves can then be used to calculate Zero
Order, First Order and Second Order reaction rates.

You can choose an automatic or manual estimate for the First
Order and Second Order Marquardt fitting.

This application also enables you to correct samples for a baseline
during the scan. You can choose a 100%T baseline, or you can
select from other baseline options such as a zero baseline
correction that will apply both a 100%T and a 0%T baseline
correction to your sample scans.
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Refer to the online Help (see section 3.3) for a description of the
settings in the Scanning Kinetics application.

3.1.13 Simple Reads
The Simple Reads application is used to perform quick absorbance
readings of samples at single wavelengths.

To configure the settings for the absorbance reading, click on the
“Setup” button or select Setup from the Menu line. Then all you
have to do is select the “Zero” button to zero the instrument, then
select “Read” to take a reading.

Refer to the online Help (see section 3.3) for a description of the
settings in the Simple Reads application.

3.1.14 Sunglasses
The Cary Solascreen system is designed to test and determine the
penetration of solar ultraviolet radiation in the range of 280 nm to
400 nm (UVR) through sunglasses and sunglare filters. It tests
non-prescription general-use lenses not designed to attenuate
solar radiation according to the Australian/New Zealand, British or
American Fabric Standards.

Refer to the online Help (see section 3.3) for a description of the
settings in the Sunglasses application.

3.1.15 System Information
The System Information application allows you to enter company
and instrument information, and specify headers, footers and
bitmap or icon files to be used in reports (e.g. your company logo).

System Information allows you to specify the default settings for
the Hint text, such as the Hint Pause (the length of the delay before
the hint appears when the pointer is moved over a control) and
Hint Hide Pause (the time the hint stays visible for if the pointer is
not moved off the control). These settings will be used by the other
Cary WinUV applications.

Refer to the online Help (see section 3.3) for a description of the
settings in the System Information application.
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3.1.16 Thermal (not available for Cary 50)
The Thermal application is used to perform thermal DNA analysis,
enabling you to calculate Tm using the various thermoelectric Cary
accessories. Once the data is collected, you can choose to
calculate the Tm value by either the derivative or hyperchromicity
methods.

Refer to the online Help (see section 3.3) for a description of the
settings in the Thermal application.

3.1.17 Validate
The Validate application enables you to carry out a number of
performance tests to verify that the system is performing according
to specification. Refer to the online Help (see section 3.3) for more
information.

An optional Validation package is also available from Varian,
providing detailed information on the functional specification and
development process of the Cary system. It also contains detailed
DQ/IQ/OQ documentation to assist your initial and on-going
validation activities.

3.2 Working with the Cary WinUV software
This section describes the various components of the software,
and how to use them. A typical screen is as follows:
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3.2.1 Menu line
Each application contains a Menu line directly beneath the window
title bar. This bar displays a number of commands, e.g. File, Edit,
View and Help.

Commands can be accessed by clicking on the desired item with
the mouse or pressing Alt  and the active (underlined) letter in the
menu name (e.g. Alt +E to access the Edit menu). This will display
a menu list. The options in the menu list can be accessed in the
same manner. For a description of the various menu items and
options refer to the online Help.

✒ Note When menu items or options appear grayed, they are unavailable
for selection.

3.2.2 Toolbar
In some applications, such as Concentration and Scan, a Toolbar
appears directly under the Menu line, containing a number of
buttons which provide shortcuts to various functions in the
software. To select a toolbar button, click on it with the mouse.

✒ Note The Toolbar may not be visible. To display the Toolbar, select
Toolbar from the View menu. Conversely, if you wish to maximize
your viewing area you can hide the Toolbar by selecting Toolbar
from the View menu. (The options in the Toolbar are also available
from the menu.)

To find out what a particular button does, hold the cursor over the
button for a short time. After a brief delay, a Hint will appear
showing what the button is used for.

3.2.3 Command buttons

Command buttons are used to carry out the action specified on the
button or to access a related dialog.

Some applications, such as Concentration and Scan, have a group
of buttons present on the left-hand side of the application window.
These buttons provide shortcuts to various functions such as
instrument setup and printing.
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✒ Note The Command buttons may not be visible. To display the buttons,
select Buttons from the View menu. Conversely, if you wish to
maximize your viewing area you can hide the buttons by selecting
Buttons from the View menu. (The Command button options are
also available from the menu.)

To select a command button, click on it with the mouse, or press
the Tab key to move the focus to the button and press Enter .

3.2.4 Dialog boxes
In some cases, selecting a menu option or pressing a command
button will activate a dialog box. This is a box that contains a
number of different input fields relevant to that operation.

You can move the focus from field to field in a dialog box either by
clicking on each entry item with the mouse or by pressing the Tab
and Arrow  keys to move the cursor from field to field. After
entering/changing any values in a dialog box, press “OK” to close
the dialog and save the changes.

3.2.5 Controls/settings
There are a number of different field types used in the WinUV
software. This section describes the fields appearing throughout
the software and how to enter values in these fields.

✒ Note Fields that are unavailable for selection are said to be disabled and
appear grayed.

Entry fields

Entry fields accept text or numeric input. To make an entry, move
the focus to the appropriate field, type in the required value, then
move the focus elsewhere to accept the entry. You can modify
numeric entry fields by pressing the up arrow  or down arrow  keys
to increment or decrement the value by a predefined value.
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Radio buttons

Radio buttons are small, round buttons that are used to make a
selection from a series of mutually exclusive items. You can select
a radio button with the mouse by clicking on the button or the text
beside it. Alternatively, you can move the focus to the group of
buttons then select the desired option using the arrow keys .
Selecting an option will deactivate all other options in the group as
only one option may be selected at a time.

Checkboxes

Checkboxes are small squares used to turn an option on or off. A
checkbox item is selected when a tick (✓) appears in the
checkbox. Within a group, any number of checkboxes may be
selected.

To select or deselect a checkbox, simply click on it or the text
beside it with the mouse. Alternatively, move the focus to the group
of checkboxes, use the arrow keys  to position the focus on the
desired option and press the spacebar  to select or deselect it.

Drop down list

A drop down list is a selection field with an arrow icon to the right of
it. Clicking on the arrow icon with the mouse, or pressing F2 when
the field has the focus, displays the list of options available for
selection.

To make a selection from the list click on it once, or use the arrow
keys to move the highlight bar to the desired option and press F2
again to accept the selection.
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Table controls

Table controls (or multi-column controls) look like a table or
spreadsheet. They contain cells that act as entry fields,
distinguished by a white background. To edit the cell contents,
double-click on the cell or move the focus to the field and press F2.

3.2.6 Hint text
You can obtain Hint text for a particular control or field by
positioning the pointer over the control/field name for a short time.
After a short delay a brief hint will appear describing what the
control or field does. If you hold the pointer over an entry field, the
valid range for that field will appear.

If these hints do not appear, select Hints from the View menu to
enable them. Conversely, if the hint text is enabled and you wish to
turn it off, select Hints from the View menu.

✒ Note You can alter the properties of the hints, such as the length of the
delay before hints appear, from the Hints tab in the System
Information application.

3.2.7 Status line
The Status line displays the current instrument status. Refer to the
online Help for more information (see section 3.3).

3.2.8 File extensions
The various files, such as method files, report files and graphic
files, are saved with a three letter extension that is representative
of the type of file, and the application that created the file.
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The following is used to represent the various file types:

File Type Extension

Methods .M**

Data .D**

Report .R**

Graph Template .G**

Batch .B**

The following is used to represent the various applications:

Application Extension

Advanced Reads .*AB

Concentration .*CN

Dissolution# .*TD

Enzyme Kinetics .*EK

Fabric Protection .*FP

Kinetics .*KN

RNA/DNA .*DN

Scan .*SW

Scanning Kinetics .*SK

Simple Reads .*SR

Sunglasses .*SG

Thermal‡ .*TM

Validate .*VO
#Not for Cary 400/500
‡Not for Cary 50

For example, a method file from the Concentration application
would have the file extension ‘.MCN’.
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✒ Note To allow you to identify the different file types in Windows Explorer,
you need to disable the Windows option which hides filename
extensions. To do this select Options from the View menu in
Windows Explorer and deselect the ‘Hide MS-DOS file extensions
for file types that are registered’ option on the View tab.

3.3 Online Help
The Cary WinUV software includes extensive online Help, which
serves as your primary source of information on how to use your
Cary system. It contains descriptions of the various windows,
dialogs and fields that make up the software, as well as
step-by-step instructions to help you perform various tasks.

3.3.1 Getting help
Since the help system is so extensive, it is advisable to familiarize
yourself with the contents of the online Help by viewing the Cary
Home page. To do this, select Help Topics from the Help menu in
any application. The Cary Home page will appear in the browser.

To access the online Help for a particular application, start the
application and select application Help (e.g. Scan Help) from the
Help menu (or press the F1 button). This will open the Help
specific to the selected application in the browser.
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3.3.2 Navigating the Help
You can move around the Help using the Contents window
(pictured below).

✒ Note To display the Contents window, press the “Show” button in the
Browser menu.
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The Contents list is manipulated by clicking on the icons and the
associated text:

❑ To expand/contract a section in the Contents list, double-click
on the ‘bookcase’ or ‘folder’ icon for that section, or click on
the +/- sign next to the icon.

❑ To display a topic, click on the text associated with that topic.

The topics in the Help are often cross-referenced with other related
topics. A cross-reference appears as text with a solid underline
(blue by default). To jump to the related topic, click on the
underlined text with the mouse. To return to the previous topic,
click on the “Back” button in the Browser toolbar.

3.3.3 Searching for Help
You can quickly search the Help system for specific information
using key words.

To search for information on a particular subject:

1. Select the Search tab.

2. Enter the word(s) you want to search for and press the “List
Topics” button or click Return  on the keyboard to list all the
relevant documents containing the search word.

The number of topics found will be displayed. You can select
to view the topics in alphabetical order by clicking ‘Title’ at the
top of the list, or in the order they appear in the Help by
clicking ‘Rank’.

3. Select the desired topic from the list by clicking on it with the
mouse then pressing the “Display” button. Alternatively,
double click on the topic. All occurrences of the key word will
appear highlighted.

4. If this does not provide the information you require, enter a
more specific word or additional words in the keywords field
and try again. You can enter the words AND, OR, NEAR and
NOT inbetween your key words. These are accessible by

clicking  to the right of the keywords field.

Another way to narrow your search is to use the checkboxes
at the bottom of the Search page. For example, selecting
‘Search titles only’ will only list those Help topics containing
the key word in the title.
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3.3.4 Finding key words within a Help topic
You can skip to a section of interest in a Help page by searching
for a relevant word.

To find a key word within a Help topic:

1. Click anywhere on the Help page.

2. On the keyboard, hold down the Ctrl key and press F. The
Find dialog will appear.

3. Enter the word you wish to look for in the Find what: field.

4. If you like, limit the Find using the checkboxes. eg. Select
‘Match case’ to ignore key words with upper and lower cases
different to that entered.

5. Select the Direction of the Find. Select Up to search for the
key word from the bottom of the page upwards, or Down to
start the Find from the top.

6. Press the “Find Next” button or press the Enter  key to begin
the Find. The first occurrence of the designated word will be
highlighted.

7. Press the “Find Next” button or Enter  repeatedly to jump to
other occurrences of the key word. When all instances of the
word have been found, the message “Finished searching the
document” will be displayed.

3.3.5 Tracking ‘favorite’ Help topics
You can keep a list of useful Help topics using the ‘Favorites’
option.

If you come across a topic you may wish to refer to again, follow
these steps:

1. Select the ‘Favorites’ tab.

2. The title of the page currently visible will be present in the
Current topic: field at the bottom of this tab.

3. Press the “Add” button to include this topic in the Favorites list.
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If you would like to view this page later on, you can simply select
the Favorites tab and highlight the topic of interest by clicking on it,
then click the “Display” button. (Alternatively, double click on the
topic.)

If a topic is no longer required in the Favorites list, highlight it then
press the “Remove” button.

3.3.6 Printing the Help
You can print the current Help topic for a particular application.

To obtain a printed copy of the current Help topic accessed from
the ‘Search’ or ‘Favorites’ facility:

1. Press the “Print” button at the top of the Help window or click
anywhere in the Help window, hold down the Ctrl key on your
keyboard and press P. This will open the Print dialog.

2. Press the “OK” button.

The topic will be printed on the default printer.

If you have accessed the topic you would like to print by clicking on
it in the ‘Contents’ listing, you may still access the Print dialog by
clicking anywhere in the Help window, holding down the Ctrl key
on your keyboard and pressing P.

However, pressing the “Print” button will bring up the Print Topics
dialog. This gives you the option of printing the selected topic only
or the selected heading and all subtopics. Once you have made
your selection and pressed the “OK” button, then the Print dialog
will appear. Press “OK” here to print your selection on the default
printer.

To change the default printer:

1. Select the appropriate printer from the Name drop down list in
the Printer group of the Print dialog.

2. Click “Properties” to display the printer Properties dialog.
Change any settings, if required, then click “OK” to exit the
Properties dialog.

3. Click “OK” to close the Print dialog.

For more information on changing the printer options, hold the
cursor over the area of interest in the Print dialog and press the F1
key.
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4 How to…

This chapter provides step-by-step instructions on how to perform
operating procedures using your Cary instrument and various
software applications.

For more detailed information on the software applications or your
Cary instrument, refer to the extensive online Help (see section 3.3
for instructions on using the Help).

Step-by-step instructions for common measurements are provided
for the following Cary software applications:

❑ Advanced Reads ❑ RNA/DNA

❑ Concentration ❑ Scan

❑ Dissolution ❑ Scanning Kinetics

❑ Enzyme Kinetics ❑ Simple Reads

❑ Fabric Protection ❑ Sunglasses

❑ Kinetics ❑ Thermal

4.1 Advanced Reads

4.1.1 How to manually read samples
This demonstrates how to read samples using no accessories.

Start the Advanced Reads application

1. On the Windows Taskbar, click “Start” to display the Start
menu.

2. Move the cursor over the Programs menu item to display the
Programs menu.

3. Select Advanced Reads in the Cary WinUV menu.
4. Select your instrument type if necessary and press “OK” to

open the Advanced Reads application.
(Alternatively, you can select the Advanced Reads icon in the
Cary WinUV folder on the desktop.)
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✒ Note If you are running a GLP system, you may be prompted to enter a
password before accessing the Advanced Reads application.

Set up data collection parameters

5. Setup dialog
Click the “Setup…” button or select Setup from the Menu line
to display the Setup dialog and specify the method
parameters for a new method.

To do this:

Set up instrument parameters such as wavelength, SBW, Y
mode etc.

6. Setup dialog | Cary tab
(a) In the Wavelength field enter the wavelength that you

want monitored.
(b) In the Ave Time field enter the required value. A good

starting point is 0.1 sec.
(c) If you are not using a Cary 50, enter the required

spectral bandwidth in the SBW field. Use the maximum
setting unless your method specifies another value.

✒ Note If using a microcell a smaller SBW should be selected.

(d) Select ‘Replicates’ or ‘Sample Averaging’. For
Replicates, enter the number of replicates of each
sample that you would like read. For Sample Averaging,
enter ‘2’ for duplicate aliquots of the same solution or ‘3’
for triplicate aliquots.

(e) Select the ordinate mode you require from the drop
down list in the Y Mode field. Enter a Factor value if you
have selected Abs*F.

Set up lamp options

7. Setup dialog | Options tab
If you are using a Cary 50, proceed to step 8.

(a) Select the Options tab.
(b) Check the ‘Auto lamps off’ checkbox if you want to

automatically turn off the lamps at the end of the collect.
This option enables you to preserve the lifetime of the
lamps. It is especially useful for when performing reads
overnight or unattended for long periods of time.

(c) Click on the UV/Vis radio button if you want both the
lamps on during sample reading.



Cary WinUV

4-3

(d) Enter the wavelength at which you would like the source
lamp to change from the UV to the Vis/NIR lamp. The
recommended changeover is 350 nm for lamps with a
UV cutoff. If you are using a Cary 500, enter the detector
changeover wavelength as well.

(e) In the Beam Mode group, select the beam mode that
you require. In most cases this should be ‘Double Beam’
and ‘Normal’.

Set up accessories

8. Setup dialog | Accessories tabs
Select the Accessories 1 and Accessories 2 tabs and make
sure that no accessories are selected.

Set up reporting and printing requirements

9. Setup dialog | Reports tab
(a) Select the Reports tab and specify your reporting

requirements for this method.
(b) Enter your name in the Name entry field.
(c) Enter a comment relating to your experiment in the

Comment entry field.
(d) Set up your report style by selecting the appropriate

checkboxes in the Options group.

For example, select the AutoPrint checkbox to obtain a
printout of your report automatically.
Select the Parameters checkbox to include your
experimental parameters in the report.

✒ Note If AutoPrint is selected, then the system will send the report
information to the specified printer as well as the Report area.
However if AutoPrint is not selected, the report will only be sent to
the Report area.

(e) Select the Autoconvert option you require. If you select
‘ASCII (csv)’ or ‘ASCII (csv) with Log’, then at the end of
the data collection the system will automatically generate
a report and store the data both in the Cary format as
well as ASCII XY pairs format in the current folder.

Set up your samples and increment names

10. Setup dialog | Samples tab
(a) Select the Samples tab. This dialog box allows you to

enter a list of sample names that will be used during
your analysis.
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(b) Enter the number of samples that you are going to use in
the Number of Samples field. The table below this field
will expand or contract to match your choice.

(c) In the Samples table (in the Sample Names group),
enter the name of each sample. You can enter up to 20
characters for each name.

(d) If the samples have the same name with a different
numeric extension, enter the name in the first sample
position and then press the “Increment” button.

Set up storage of collected data

11. Setup dialog | Auto Store tab
(a) Select the Auto Store tab.
(b) Select ‘Storage off’. The method, collected data and

report will not be automatically saved. However, you can
manually save it all at the end of the collection.

Set up visual system monitoring

12. Select the Show Status Display checkbox on any of the tabs
to display various information fields on your current reaction.

Finish setup

13. Once you are satisfied with your method setup click “OK” to
confirm any changes you have made and close the Setup
dialog.

Zero the instrument

14. To zero the instrument:
(a) Click the “Zero” button. Alternatively, select Zero in the

Commands menu to perform a zero. The Zero dialog
box will appear.

(b) Place a blank in the sample compartment and press
“OK”.

Read samples

15. To read samples:
(a) Click the “Start” button. The Sample Selection dialog box

will appear.
(b) Select the samples you would like to read then click

“OK”.
(c) The Present Sample dialog box will prompt you to place

the appropriate sample in the sample compartment.
Press “OK” to read the sample. (If replicates have been
nominated, then the result is reported after the final
sample replicate is read.)

(d) Repeat for the remaining samples.
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Save your data

16. To save your data:
(a) Click on the File menu item and select Save Data As.
(b) Enter the file name for this read in the File name field.
(c) Click “Save”. The data will be stored as a Batch file.

4.2 Concentration

4.2.1 How to perform a calibration and manually
measure concentrations

This demonstrates how to perform a multi-standard calibration and
measure sample concentrations using no accessories.

Start the Concentration application

1. On the Windows Taskbar, click “Start” to display the Start
menu.

2. Move the cursor over the Programs menu item to display the
Programs menu.

3. Select Concentration in the Cary WinUV menu.
4. Select your instrument type if necessary and press “OK” to

open the Concentration application.
(Alternatively, you can select the Concentration icon in the
Cary WinUV folder on the desktop.)

✒ Note If you are running a GLP system, you may be prompted to enter a
password before accessing the Concentration application.

Set up data collection parameters

5. Setup dialog
Click the “Setup…” button or select Setup from the Menu line
to display the Setup dialog and specify the method
parameters for a new method.

To do this:

Set up instrument parameters such as wavelength, spectral
bandwidth, Y mode etc.

6. Setup dialog | Cary tab
(a) In the Wavelength field enter the wavelength that you

want monitored.
(b) In the Ave Time field enter the required value. A good

starting point is 0.1 sec.
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(c) Unless you are using a Cary 50, enter the required
spectral bandwidth in the SBW field. Use the maximum
setting unless your method specifies another value.

✒ Note If using a microcell a smaller SBW should be selected.

(d) Select ‘Replicates’ (if you require them) and set the
value to the number of replicates that you are using.

(e) Unless you are using a Cary 50, select the Y mode you
require. Click “Abs” to specify the Absorbance mode or
“Emission” if you are measuring fluorescence.

(f) Enter an upper range and lower range value in the Y min
and Y max entry fields to specify the displayed ordinate
range. Note that these are starting values only. The
WinUV software will automatically rescale the calibration
graph as the standards are measured.

Set up the calibration
7. Setup dialog | Standards tab

(a) Select the Standards tab to set up the standards and
their parameters associated with the data collection.

(b) Select ‘Calibrate During Run’ to perform a calibration
when the “Start” button is pressed.

(c) Set the appropriate Units for your standards for reporting
purposes.

✒ Note If you are performing a calibration for use with the Dissolution
application, then the Units specified must be mg/mL or g/L.

(d) Set the Standards field to the number of standards that
you are using in your calibration. The table below this
field will expand or contract to match your choice.

(e) In the Standards table, enter the concentration of each
standard into the ‘Conc’ column.

(f) Select the type of curve fitting required for your
calibration in the ‘Fit Type’ group.

(g) Enter the required R2 value or correlation coefficient into
the Min R2 field. The closer the number is to 1.000 the
better the fit. Typically, 0.95 is used.

Set up lamp options
8. Setup dialog | Options tab

If you are using a Cary 50, proceed to step 9.

(a) Select the Options tab.
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(b) Check the ‘Auto Lamps Off’ checkbox if you want to
automatically turn off the lamps at the end of the collect.
This option enables you to preserve the lifetime of the
lamps. It is especially useful for when performing
Concentration runs overnight or unattended for long
periods of time.

(c) Click on the “UV/Vis” button if you want both the lamps
on during the run.

(d) Enter the wavelength at which you would like the source
lamp to change from the UV to the Vis/NIR lamp. The
recommended changeover is 350 nm for lamps with a
UV cutoff. If you are using a Cary 500, enter the detector
changeover wavelength as well.

(e) In the Beam Mode group, select the beam mode that
you require. In most cases this should be ‘Double Beam’
and “Normal”.

Set up accessories
9. Setup dialog | Accessories tab

Select the Accessories tab and make sure that no
accessories are selected.

Set up reporting and printing requirements

10. Setup dialog | Reports tab
(a) Select the Reports tab and specify your reporting

requirements for this method.
(b) Enter your name in the Name entry field.
(c) Enter a comment relating to your experiment in the

Comment entry field.
(d) Set up your report style by selecting the appropriate

checkboxes in the Options group.

For example, select the AutoPrint checkbox to obtain a
printout of your report automatically.
Select the Parameters checkbox to include your
experimental parameters in the report.
Select the Graph checkbox to include a calibration graph
in the generated report.

✒ Note If AutoPrint is selected, then the system will send the report
information to the specified printer as well as the Report area.
However, if AutoPrint is not selected, the report will only be sent to
the Report area and can be viewed by selecting the Report option
in the View menu.
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(e) Select the Autoconvert option you require. If you select
‘ASCII’ or ‘ASCII with Log’, then at the end of the data
collection the system will automatically generate a report
and store the data both in the Cary format as well as
ASCII XY pairs format in the current folder.

Set up your samples and increment names

11. Setup dialog | Samples tab
(a) Select the Samples tab. This dialog box allows you to

enter a list of sample names that will be used during
your analysis.

(b) Enter the number of samples that you are going to use in
the Number of Samples field. The table below this field
will expand or contract to match your choice.

(c) In the Samples table, enter the name of each sample.
You can enter up to 20 characters for each name.

(d) If the samples have the same name with a different
numeric extension, enter the name in the first sample
position and then press the “Increment” button.

Set up your samples for weight and volume correction
12. Setup dialog | Samples tab

(a) Select ‘Corrections’ in the Weight/Volume Corrections
group to activate the correction facility.

(b) Enter the theoretical sample weight in the Method
Weight field. This is the weight of the sample specified in
your method.

(c) Enter the weight units in the Units field.
(d) Enter the theoretical sample volume in the Method

Volume field. This is the volume to which the method
tells you to make the sample.

(e) Enter the volume units in the Units field.
(f) In the Samples table, enter the actual weight and volume

for each sample.

Set up storage of collected data
13. Setup dialog | Auto Store tab

(a) Select the Auto Store tab.
(b) Select ‘Storage off’. The method (with calibration),

collected data and report will not be automatically saved.
However, you can manually save it all at the end of the
collection.
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Set up visual system monitoring

14. Select the Show Status Display checkbox on any of the tabs
to display various information fields on your current reaction.

Finish setup

15. Once you are satisfied with your method setup click “OK” to
confirm any changes you have made and close the Setup
dialog.

Zero the instrument

16. To Zero the instrument:
(a) Click the “Zero” button to zero the system. Alternatively,

select Zero in the Commands menu to perform a zero.
(b) Place a blank in the sample compartment and press

“OK”.

Perform the calibration

17. To perform the calibration:
(a) Press the application “Start” button or select Start in the

Commands menu. The Standard/Sample Selection
dialog box will appear.

(b) Select the standards and samples to be used in the
analysis. By default all standards and samples are
selected.

(c) Click “OK” to exit the Standard/Sample Selection dialog
box.

(d) The Present Standard dialog box will prompt you to
place the appropriate standard in the sample
compartment. Press “OK” to measure the standard.

(e) Repeat until you have measured all the standards. The
Cary will calculate the calibration and the correlation
coefficient.

✒ Note If the set correlation coefficient (R2) value is not met, the Cary will
prompt you with ‘Min R2 test failed’. When you press “OK”, the Cary
will then prompt you with ‘There is no valid calibration. Proceed in
Abs (or Emission)?’. If you click “Cancel”, the Concentration run
will finish. If you click “Yes”, the Cary will measure the absorbance
or emission of any presented samples, but will not generate a
concentration.



Cary WinUV

4-10

Measure the sample

18. To measure sample concentration:
(a) Once all the standards have been read, the Present

Sample dialog box will prompt you to place the
appropriate sample in the sample compartment. Press
“OK” to measure the sample and calculate its
concentration. (If replicates have been nominated, then
the concentration is calculated after the final sample
replicate is read.)

(b) Repeat for the remaining samples.

Save the data

19. To save your data:
(a) Click on the File menu item and select Save Data As.
(b) Enter the file name for this Concentration run in the File

name field.

4.3 Dissolution
The following Dissolution How to… procedures are described.

❑ How to perform a Dissolution run (Cary 100/300)

❑ How to perform a Dissolution run (Cary 50)

4.3.1 How to perform a Dissolution run (Cary
100/300)

Open the Dissolution application

1. On the Windows Taskbar click “Start” to display the Start
menu.

2. Move the cursor over the Programs menu item to display the
Programs menu.

3. Select Dissolution in the Cary WinUV menu to open the
Dissolution application.

4. Select your instrument type (if necessary) and press “OK” to
open the Dissolution application.
(Alternatively, you can double click on the Dissolution icon in
the Cary WinUV folder on the desktop.)
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✒ Note If you are running a GLP system you may be prompted to enter a
password before accessing the Dissolution application.

Set up method parameters

5. Setup dialog
Click the “Setup…” button or select Setup from the Menu line
to display the Setup dialog box and specify the method
parameters for a new method.

To do this:

Set up instrument control and run timing parameters

6. Setup dialog | Cary tab
On the Cary tab, specify the Instrument parameters for your
analysis as follows:

(a) Enter the Wavelength, Ave (averaging) Time, and SBW
you require in the corresponding entry fields.

(b) Select the ordinate mode you require (“Abs”,
“%Dissolved” or “mg Dissolved”).

(c) Enter an upper range and lower range value in the Y Min
and Y Max entry fields to specify the displayed ordinate
range.

7. Specify the Collect Timing parameters:
(a) Select the units for the collect. Click “Hours” to specify

the time in hours or “Minutes” to specify the time in
minutes.

(b) Enter the number of stages you require in the Number of
Stages entry field. The number you set here will be
reflected in the table below.

✒ Note Using more than one stage enables you to collect data more
frequently during the stages with a fast tablet dissolution rate and
to collect data less frequently where you know there will a slower
rate of dissolution.

(c) Enter the Cycle and End time for each stage.

Set up the bath controls including temperature, stir and pump
times

8. Setup dialog | Bath tab
(a) Select the Bath tab to specify the Bath settings and

controls for your analysis.
(b) Select the Apparatus method type, the number of baths

to be used and the vessels to be analyzed.
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(c) If Dual Pathlength is required, select the Use Dual
Pathlength checkbox and specify whether you wish the
data to be collected in the rear or front cells.

✒ Note The Dual Pathlength option is not valid for a two bath system or
when analyzing vessels Samples + Std + Blank on a one bath
system.

(d) Enter the VanKel Bath temperature, Method temperature
and Temperature Tolerance.

✒ Note Select the Warm up Bath checkbox if you would like to warm up
the bath at a preset time. Click  on the Bath tab to specify a date
and time to begin the bath warmup.

(e) Enter the various pump times in the corresponding entry
fields.

(f) Enter the Stir Rate in revolutions per minute.
(g) Select the Infinity Stir Time checkbox if you want to

perform an infinity measurement at the end of the last
collect cycle.

(h) Select the Initial Fast Stir checkbox if you want to
perform a fast stir after adding the medium solution to
the vessels to remove any trapped air bubbles around
the paddles/baskets.

Set up the sample information for tablet information and
potency correction

9. Setup dialog | Samples tab
(a) Select the Samples tab and enter the sample information

for your analysis.
(b) Enter the Tablet Potency, Vessel Volume and the type of

Sample Medium used.
(c) Check the Weight Correct checkbox to apply the weight

corrections.
(d) Enter the Method Weight for each bath unit.
(e) Enter the Actual tablet weights for each vessel.

Set up the standard options for your collection

10. Setup dialog | Stds tab
(a) Select the Stds tab to specify the Standards Values.
(b) Enter the 100% Std Abs, Standard Weight and Standard

Volume in the corresponding entry fields.
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✒ Note The 100% Std Abs entry field will be disabled if the specified
Vessels type is Sample + Std or Sample + Std + Blank; or if the
Use Multi-Std Calibration checkbox has been checked.

(c) Specify the Std Medium and Std Reference material
used for the analysis.

(d) If required, check the Use Multi-Std Calibration checkbox
to turn on the Multi-Std Calibration facility.

✒ Note The Multi-Std Calibration facility requires a stored calibration to be
selected by clicking on . The stored calibration must be calibrated
and generated using the Concentration application with the same
method parameters used in the Dissolution method.

(e) If measuring a standard online, check the Use Limits
checkbox to apply the Standard Control Limits during the
analysis.

(f) Enter the Standard Limits values when using the
Standard Control Limits facility.

(g) Specify the If Outside Limits action when using the
Standard Control Limits.

Set up the collection limits to ensure samples are within
laboratory specifications

11. Setup dialog | Limits tab
(a) Select the Limits tab to specify the Sample Control

Limits.
(b) Check the Use Limits checkbox if you want to apply

Sample Control Limits to the analysis.
(c) Enter the number of limits you require in the Number of

Limits entry field. The number you set here will be
reflected in the table below.

(d) Enter the Limit Information you require to be applied to
the Sample analysis.

✒ Note The time points entered will default to the nearest time points at
which the measurement was made. No extrapolation of data is
allowed.

(e) Specify the If Outside Limits action when using the
Sample Control Limits.

Set up the reporting and printing requirements

12. Setup dialog | Reports tab
(a) Select the Reports tab to specify your reporting

requirements for this method.
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(b) Enter your name in the Name entry field.
(c) Enter a comment relating to your experiment in the

Comment entry field.
(d) Setup your report style by selecting the appropriate radio

buttons in the Options group.

For example, select the Auto Print checkbox to obtain a
print out of your report automatically.
Select the Parameters checkbox to include your
experimental parameters in the report.
Select the Graph checkbox to include a graph in the
generated report.

✒ Note If Auto Print is selected, then the system will send the report
information to the specified printer as well as the Report area.
However if Auto Print is not selected, the report will only be sent to
the Report area and can be viewed by selecting the Report option
in the View menu.

(e) Specify which time points are to be used in the report.
For example, select either All time points, Sample
Control Limit time points or User defined time points to
appear in the report.

(f) Enter the % Dissolved time points you require in the
report.

✒ Note To edit the Time and % Dissolved point tables click the right mouse
button over the respective tables for the menu options.

(g) Select the AutoConvert option you require.

If you choose Select for ASCII (csv) or Select for ASCII
(csv) with Log, then at the end of the data collection the
system will automatically generate a report and store the
data both in the Cary format as well as ASCII XY pairs
format in the current folder.

Set up visual system monitoring

13. Select the Show Status Display checkbox on any of the tabs
to display various information fields on your current reaction.

Finish setup

14. Once you are satisfied with your method Setup click “OK” to
close the Setup dialog.
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Check the placement of the Dissolution flowcells

15. Click the “Loading Guide” button to check that the dissolution
flowcells have been positioned correctly in the 8 x 6 Multicell
Holder Accessory. This identifies the correct dissolution
flowcell positions for the type of method setup specified for
the run, e.g. Samples + Std dual path rear cells etc.

✒ Note Make sure you insert the flowcells into the Multicell Holder with the
flow arrow in the right direction.

Once you are satisfied with your positioning click “OK” to exit
the Cell Loading Guide.

16. Ensure that the tubing from the bath(s) and pump is securely
connected to the dissolution flowcells.

✒ Note Each dissolution flowcell will have a downward arrow indicating the
inlet flow. Care must be taken when handling the dissolution
flowcells to ensure that the cell windows are not scratched,
chipped or marked with fingerprints. The tubing to and from the
cells, pump and bath must be checked for leaks to ensure
analytical integrity.

Check system communication and ensure correct mechanical
responses

17. To check communication and mechanical responses:
(a) Click the “Diagnostics” button or select Diagnostics from

the Commands menu to check the bath and Multicell
Holder communication.

(b) Select the cells in the Cary Apparatus group and check
that the correct movement to each cell occurs.

(c) Select the bath you would like to test.
(d) Select the “Communication Setup” button and enter the

correct settings.
(e) Click on the “Bath Communication Tests” button to start

the test sequence. Follow the various prompts that
appear.

Zero the instrument

18. To zero the instrument:
(a) Click the “Zero” button to display the Zero All Cells

dialog.
(b) Click “OK” to zero each cell.
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Start the Dissolution run

19. To start the run:
(a) Press the “Start” button to start a data collection.

Alternatively you can select Start in the Commands
menu.

(b) The Sample ID dialog will appear. Enter your sample
name here and press “OK”.

(c) The ‘Save As…’ dialog box will appear prompting you to
save the method, and collected data in a Dissolution
Batch file (*.BTD).

(d) Select the folder in which you want to save your
Dissolution Batch file.

(e) Enter the name of the file in the File name entry field
then click “Save”. The method, collected data and
generated report will be saved.

20. A number of prompt messages will appear during the
analysis. Read the message carefully and select the
appropriate response. The type of prompt messages that will
appear will depend on the method parameters used for the
data collect.

✒ Note During a run, the software will ask you if you want to use the
automatic temperature sensing in all vessels. If you are using a
7000 bath, then you must choose "No” and the software will use
the temperature probe(s) in the bath(s) as the control temperature.

4.3.2 How to perform a Dissolution run (Cary 50)
Open the Dissolution application

1. On the Windows Taskbar click “Start” to display the Start
menu.

2. Move the cursor over the Programs menu item to display the
Programs menu.

3. Select Dissolution in the Cary WinUV menu to open the
Dissolution application.

4. Select your instrument type (if necessary) and press “OK” to
open the Dissolution application.
(Alternatively, you can double click on the Dissolution icon in
the Cary WinUV folder on the desktop.)

✒ Note If you are running a GLP system you may be prompted to enter a
password before accessing the Dissolution application.
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Set up method parameters

5. Click the “Setup…” button or select Setup from the Menu line
to display the Setup dialog box and specify the method
parameters for a new method.
To do this:

Set up instrument control and run timing parameters

6. Setup dialog | Cary tab
On the Cary tab, specify the Instrument parameters for your
analysis as follows:

(a) Enter the Wavelength and Ave (averaging) time you
require in the corresponding entry fields.

(b) Select the ordinate mode you require (“Abs”,
“%Dissolved” or “mg Dissolved”).

(c) Enter an upper range and lower range value in the Y Min
and Y Max entry fields to specify the displayed ordinate
range.

7. Specify the Collect Timing parameters:
(a) Choose the units for the collect. Select “Hours” to specify

the time in hours or “Minutes” to specify the time in
minutes.

(b) Enter the Number of Stages you require in the Number
of Stages entry field. The number you set here will be
reflected in the table below.

✒ Note Using more than one stage enables you to collect data more
frequently during the stages with a fast tablet dissolution rate and
to collect data less frequently where you know there will a slower
rate of dissolution.

(c) Enter the Cycle and End time for each stage.

Set up the bath controls including temperature, stir and pump
times

8. Setup dialog | Bath tab
(a) Select the Bath tab to specify the Bath settings and

controls for your analysis.
(b) Select the Apparatus method type, the number of baths

to be used and the vessels to be analyzed.
(c) If Dual Pathlength is required, select the Use Dual

Pathlength checkbox and specify whether you wish the
data to be collected in the rear or front cells.

✒ Note The Dual Pathlength option is not valid for a two bath system.
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(d) Enter the VanKel Bath temperature, Method temperature
and Temperature Tolerance.

✒ Note Select the Warm up Bath checkbox if you would like to warm up
the bath at a preset time. Click  on the Bath tab to specify a date
and time to begin the bath warmup.

(e) Enter the various pump times in the corresponding entry
fields.

(f) Enter the Stir Rate in revolutions per minute.
(g) Select the Infinity Stir Time checkbox if you want to

perform an infinity measurement at the end of the last
collect cycle.

(h) Select the Initial Fast Stir checkbox if you want to
perform a fast stir after adding the medium solution to
the vessels to remove any trapped air bubbles around
the paddles/baskets.

Set up the sample information for tablet information and
potency correction

9. Setup dialog | Samples tab
(a) Select the Samples tab to enter the sample information

for your analysis.
(b) Enter the Tablet Potency, Vessel Volume and the type of

Sample Medium used.
(c) Check the Weight Correct checkbox to apply the weight

corrections.
(d) Enter the Method Weight for each bath unit.
(e) Enter the Actual tablet weights for each vessel.

Set up the standard options for your collection

10. Setup dialog | Stds tab
(a) Select the Stds tab to specify the Standards Values.
(b) Enter the 100% Std Abs, Standard Weight and Standard

Volume in the corresponding entry fields.

✒ Note The 100% Std Abs entry field will be disabled if the specified
Vessels type is Sample + Std or Sample + Std + Blank; or the Use
Multi-Std Calibration checkbox has been checked.

(c) Specify the Std Medium and Std Reference material
used for the analysis.

(d) If required, check the Use Multi-Std Calibration checkbox
to turn on the Multi-Std Calibration facility.
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✒ Note The Multi-Std Calibration facility requires a stored calibration to be
selected by clicking on . The stored calibration must be calibrated
and generated using the Concentration application with the same
method parameters used in the Dissolution method.

(e) If measuring a standard online, check the Use Limits
checkbox to apply the Standard Control Limits during the
analysis.

(f) Enter the Standard Limits values when using the
Standard Control Limits facility.

(g) Specify the If Outside Limits action when using the
Standard Control Limits.

Set up the collection limits to ensure samples are within
laboratory specifications

11. Setup dialog | Limits tab
(a) Select the Limits tab to specify the Sample Control

Limits.
(b) Select the Use Limits checkbox if you want to apply

Sample Control Limits to the analysis.
(c) Enter the number of limits you require in the Number of

Limits entry field. The number you set here will be
reflected in the table below.

(d) Enter the Limit Information you require to be applied to
the Sample analysis.

✒ Note The time points entered will default to the nearest time points at
which the measurement was made. No extrapolation of data is
allowed.

(e) Specify the If Outside Limits action when using the
Sample Control Limits.

Set up the reporting and printing requirements

12. Setup dialog | Reports tab
(a) Select the Reports tab to specify your reporting

requirements for this method.
(b) Enter your name in the Name entry field.
(c) Enter a comment relating to your experiment in the

Comment entry field.
(d) Setup your report style by selecting the appropriate radio

buttons in the Options group.
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For example, select the Auto Print checkbox to obtain a
print out of your report automatically.
Select the Parameters checkbox to include your
experimental parameters in the report.
Select the Graph checkbox to include a graph in the
generated report.

✒ Note If Auto Print is selected, then the system will send the report
information to the specified printer as well as the Report area.
However if Auto Print is not selected, the report will only be sent to
the Report area and can be viewed by selecting the Report option
in the View menu.

(e) Specify which time points are to be used in the report.

For example, select either All time points, Sample
Control Limit time points or User defined time points to
appear in the report.

(f) Enter the % Dissolved time points you require in the
report.

✒ Note To edit the Time and % Dissolved point tables click the right mouse
button over the respective tables for the menu options.

(g) Select the AutoConvert option you require.

If you choose Select for ASCII (csv) or Select for ASCII
(csv) with Log, then at the end of the data collection the
system will automatically generate a report and store the
data both in the Cary format as well as ASCII XY pairs
format in the current folder.

Set up visual system monitoring

13. Select the Show Status Display checkbox on any of the tabs
to display various information fields on your current reaction.

Finish setup

14. Once you are satisfied with your method Setup click “OK” to
close the Setup dialog.

Check the placement of the Dissolution Flow Cells

15. Click the “Loading Guide” button or select Loading Guide from
the Commands menu to check that the dissolution flowcells
have been positioned correctly in the 18 Cell Holder
Accessory. This identifies the correct dissolution flowcell
positions for the type of method setup specified for the run,
e.g. Samples + Std dual path rear cells etc.
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✒ Note Make sure you insert the flowcells into the Multicell Holder with the
flow arrow in the right direction.

Once you are satisfied with your positioning click “OK” to exit
the Cell Loading Guide.

16. Ensure that the tubing from the bath(s) and pump is securely
connected to the dissolution flowcells.

✒ Note Each dissolution flowcell will have a downward arrow indicating the
inlet flow. Care must be taken when handling the dissolution
flowcells to ensure that the cell windows are not scratched,
chipped or marked with fingerprints. The tubing to and from the
cells, pump and bath must be checked for leaks to ensure
analytical integrity.

Check system communication and ensure correct mechanical
responses

17. To check communication and mechanical responses:
(a) Click the “Diagnostics” button or select Diagnostics from

the Commands menu to check the bath and Multicell
Holder communication.

(b) Select the cells in the Cary Apparatus group and check
that the correct movement to each cell occurs.

(c) Select the bath you would like to test.
(d) Select the “Communication Setup” button and enter the

correct settings.
(e) Click on the “Bath Communication Tests” button to start

the test sequence. Follow the various prompts that
appear.

Zero the instrument

18. To zero the instrument:
(a) Click the “Zero” button to display the Zero All Cells

dialog.
(b) Click “OK” to zero each cell.

Start the Dissolution run

19. To start the run
(a) Press the “Start” button to start a data collection.

Alternatively you can select Start in the Commands
menu.

(b) The Sample ID dialog will appear. Enter your sample
name here and press “OK”.
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(c) The Save As… dialog box will appear prompting you to
save the method, and collected data in a Dissolution
Batch file (*.BTD).

(d) Select the folder in which you want to save your
Dissolution Batch file.

(e) Enter the name of the file in the File name entry field
then click “Save”. The method, collected data and
generated report will be saved.

20. A number of prompt messages will appear during the
analysis. Read the message carefully and select the
appropriate response. The type of prompt messages that will
appear will depend on the method parameters used for the
data collect.

✒ Note During a run, the software will ask you if you want to use the
automatic temperature sensing in all vessels. If you are using a
7000 bath, then you must choose “No” and the software will use
the temperature probe(s) in the bath(s) as the control temperature.

4.4 Enzyme Kinetics
The following Enzyme Kinetics How to… procedures are
described:

❑ How to perform a temperature controlled run using the
Multicell Holder (Cary 100–500)

❑ How to perform a temperature controlled run (Cary 50)

4.4.1 How to perform a temperature controlled
run using the Multicell Holder (Cary 100–
500)

This demonstrates how to perform a multicell, multi-rate Enzyme
Kinetics run at 37 °C using the Temperature Controller accessory
with the Multicell Holder accessory (Cary 100, 300, 400 and 500).

Start the Enzyme Kinetics application

1. On the Windows Taskbar, click “Start” to display the Start
menu.

2. Move the cursor over the Programs menu item to display the
Programs menu.

3. Select Enzyme Kinetics in the Cary WinUV menu.
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4. Select your instrument type (if necessary) and press “OK” to
open the Enzyme Kinetics application.
(Alternatively, you can double click on the Enzyme Kinetics
icon in the Cary WinUV folder on the desktop.)

✒ Note If you are running a GLP system, you may be prompted to enter a
password before accessing the Enzyme Kinetics application.

Set up data collection parameters

5. Click the “Setup…” button or select Setup from the Menu line
to display the Setup dialog box and specify the method
parameters for a new method.

To do this:

Set up Multicell Holder accessory with multi zero, no blank
correction

6. Setup dialog | Accessories tab
As various options do not become available until the
appropriate accessories are selected, you need to select
these first.

(a) Select the Accessories tab.
(b) Select the Use Cell Changer checkbox to enable the

accessory.
(c) For Cary 100/300 instruments, choose the type of

Multicell Holder you are using (6 x 6 or 8 x 6).
(d) Ensure that you have this accessory installed prior to

commencing the run.
(e) Choose the Select Cells radio button and select the cells

you require from the available cells in the Use Cells
group.

✒ Note For Front Beam analysis, select the checkboxes Cell 1–Cell 6
(6 x 6) or Cell 1–Cell 8 (8 x 6). This will ensure that all front cell
positions in the Multicell Holder will be measured during your
enzyme kinetics analysis.

(f) Check the Multi Zero checkbox to turn on the Multi Zero
facility.

(g) Ensure that the Blank Correction checkbox is not
checked.
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Set up accessories for reaction temperature control and
temperature display

7. To set up accessories:
(a) If you are not using a Peltier controlled accessory (e.g.

the water thermostatted 8 x 6) ensure that you have the
Temperature Controller accessory installed prior to
commencing the run, and,

(i) Tick Automatic Temperature Setting and select
the Temperature Controller to enable the accessory.

(ii) Set the monitoring temperature by entering the
Block temperature as 37 °C. (The monitoring device
is selected in Step 8 part (d)).

(b) In the Temperature Display group, select Block and
Probe 1 to view the temperature of the Multicell Holder
block and one temperature Probe in the Status Display
window.

Set up instrument parameters such as wavelength, SBW, Y
mode etc.

8. Setup dialog | Cary tab
Select the Cary tab and specify the Instrument parameters for
your analysis.

(a) Enter the Wavelength, SBW and Ave (averaging) Time
you require in the corresponding entry fields.

(b) Select the ordinate mode you require. Click “Abs” to
specify the Absorbance mode or “%T” to specify percent
Transmittance.

✒ Note The %T mode is used when performing Fluorescence kinetics
measurements using the Total Fluorescence accessory or the
Fluorescence Fibre Optic Probe.

(c) Enter an upper range and lower range value in the Y min
and Y max entry fields to specify the displayed ordinate
range.

(d) Choose the desired temperature monitoring device in the
Monitor field. The “Start” button will not be enabled until
the temperature of the selected Monitor is within 0.5 °C
of the Block temperature set in the Accessories tab.
(Step 7 part (a)(ii)).
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Set up rate parameters such as the number of different rates
in the reaction, the speed and duration of the data collection

9. Select the Advanced Collect radio button in the Collect Timing
group. This enables you to set up different data collection
procedures for the multiple rates in your reaction.

✒ Note The Advanced Collect facility enables you to collect data more
frequently during the crucial stages of your reaction and to collect
data less frequently where you know there will not be much
activity.

(a) Enter the number of different reaction rates that you
require in the Number of Stages entry field. The number
you set here will be reflected in the table below.

(b) Vary the number of data points collected per cell per run
by setting the Dwell time for each rate Stage.

(c) Specify how long the Cary will wait after reading each
cell before it starts another reading cycle by setting the
Cycle time for each rate Stage.

(d) Specify the duration of the measurement run by setting
the Stop time for each rate Stage.

Set up lamp and graphics options

10. Setup dialog | Options tab
(a) Select the Options tab.
(b) Check the Auto Lamps Off checkbox if you want to

automatically turn off the lamps at the end of a collect.
This option enables you to preserve the lifetime of the
lamps. It is especially useful for when performing data
collections overnight or unattended for long periods of
time.

(c) Click on the UV/Vis radio button if you want both the
lamps on during the run.

(d) Enter your required Source Changeover and Detector
Changeover (Cary 500 only) wavelengths in the
corresponding entry fields.

(e) Set the monochromator exit slit height to full or reduced
(Cary 400 and 500 only).

(f) In the Display Options group, select the way in which
you want the data displayed as it is collected. Choose
the Individual Data radio button to display the collected
data of each sample in individual graph boxes. Choose
the Overlay Data radio button to superimpose the
collected data of each sample in the Enzyme Kinetics
run in one graph box.
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Set up V0 calculation

11. Setup dialog | Analyze tab
(a) Select the Analyze tab.
(b) Set up the Start and Stop times for your V0 Calculation.
(c) Enter the correct product absorptivity for your reaction.
(d) Enter the correct cell pathlenth for your reaction.

Set up calculations for the maximum rate (Vmax) and
substrate concentration that gives half the maximum rate
(Km)

12. To set up Vmax and Km calculations:
(a) Select the method by which the data obtained from your

selection in the Plot/Fit group will be calculated. Choose
Linear Least Square or Marquardt by selecting the
appropriate radio button.

(b) Choose the inhibitor model for your analysis. Select
either the Non Competitive, Competitive or
Uncompetitive radio button.

(c) Check the box/es beside the Plot/Fit type/s that will be
used to determine Vmax and Km values.

(d) Select the Auto Calculate checkbox to automatically
perform enzyme kinetics calculations on collected data
at the end of each run. These results will be displayed in
the Report area.

Set up reporting and printing requirements

13. Setup dialog | Reports tab
(a) Select the Reports tab.
(b) Enter your name in the Name entry field.
(c) Enter a comment relating to your experiment in the

Comment entry field.
(d) Set up your report style by selecting the appropriate

checkboxes in the Options group.

For example, select the Auto Print checkbox to obtain a
printout of your report automatically.
Select the Parameters checkbox to include your
experimental parameters in the report.
Select the Graph checkbox to include a graph in the
generated report.
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✒ Note If Auto Print is selected, then the system will send the report
information to the specified printer as well as to the Report area.
However if Auto Print is not selected, the report will only be sent to
the Report area and can be viewed by selecting the Report option
in the View menu.

(e) Select the Autoconvert option you require.

If you choose Select for ASCII (csv) or Select for ASCII
(csv) with Log, then at the end of the data collection the
system will automatically generate a report and store the
data both in the Cary format as well as ASCII XY pairs
format in the current folder.

Set up storage of collected data

14. Setup dialog | Auto Store tab
(a) Select the Auto Store tab to set up whether the collected

data is to be saved, and if so, when the Cary should
store the information.

(b) Select Storage On (Prompt at Start), to set up the Cary
to prompt you for file name before the start of an
Enzyme Kinetics reaction.

Set up visual system monitoring

15. Select the Show Status Display checkbox on any of the tabs
to display various information fields on your current reaction.

Finish setup

16. Click “OK” to save any changes you have made and close the
Setup dialog. Depending on the cells selected in the Multicell
Holder, the Cary may then inform you that it will perform a
dual single beam calibration. Press “OK”.

Zero the instrument

17. To zero the instrument
(a) Click the “Zero” button to zero the system. Alternatively,

select Zero in the Commands menu to perform a zero. A
Cell Loading Guide dialog box will be displayed.

(b) If you want, change the names of the blank samples.
(c) Place the blank solution(s) in the correct cell positions

and click “OK”.
The system will perform an instrument zero on the blank
solution(s).
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✒ Note If you had chosen not to use the Multi Zero facility in Step 6, the
system will prompt you to enter the blank solution into the
instrument. You must  make sure that you place the blank solution
in the cell position that is currently in the light path. Once you press
“OK”, the system will perform a zero on the cell position in the light
path, i.e. the system will not reset the Multicell Holder to position 1.

Start the run

18. To start the run:
(a) Press the “Start” button to start a data collection.

Alternatively you can select Start in the Commands
menu. Do not add your active reagent at this time. The
system will display a Cell Loading Guide dialog box.

(b) If you want, change the names of the samples.
(c) Place the sample solution(s) in the correct cell positions

and click “OK”. The system will set up the Graphics area
and then display the Save File dialog box.

(d) Enter the file name for this run in the File name field and
press “Save”. The Sync Start dialog box will appear.

(e) Reset the Multicell Holder to position to cell 1 using the
“Reset Slide” button. Add your active reagent just before
the Count Down reaches 0:00 or commence the data
collection by pressing the “OK” button.

Enter substrate and inhibitor concentrations

19. Once the run has started, enter the substrate and inhibitor
concentrations.

✒ Note If no information has been entered in the User Data Form during
the collect, no calculation is performed.

(a) Open the User Data Form, by right clicking in a graph
box and selecting User Data Form from the list or by
selecting it from the Graph menu.

(b) The table that appears has Data Names and may have
V0 values already entered in the first two columns. In the
third and fourth columns, enter your values for [S] and [I]
in µmolar/L.

(c) Press “OK”. Your [S] and [I] values are now ready to be
used in calculations, and the Cary will perform the
calculations at the end of the run.



Cary WinUV

4-29

4.4.2 How to perform a temperature controlled
run (Cary 50)

This demonstrates how to perform a single cell, multi-rate Enzyme
Kinetics run at 37 °C using the single cell Peltier accessory (Cary
50).

Start the Enzyme Kinetics application

1. On the Windows Taskbar, click “Start” to display the Start
menu.

2. Move the cursor over the Programs menu item to display the
Programs menu.

3. Select Enzyme Kinetics in the Cary WinUV menu.
4. Select your instrument type (if necessary) and press “OK” to

open the Enzyme Kinetics application.
(Alternatively, you can double click on the Enzyme Kinetics
icon in the Cary WinUV folder on the desktop.)

✒ Note If you are running a GLP system, you may be prompted to enter a
password before accessing the Enzyme Kinetics application.

Set up data collection parameters

5. Click the “Setup…” button or select Setup from the Menu line
to display the Setup dialog box and specify the method
parameters for a new method.
To do this:

Ensure Multicell Holder accessory is not selected

6. Setup dialog | Accessories tab
As various options do not become available until the
appropriate accessories are selected, you need to select
these first.

(a) Select the Accessories tab.
(b) Ensure the Use Cell Changer checkbox is not selected.

Set up accessories for reaction temperature control and
temperature display

7. To set up accessories:
(a) In the Temperature group, check ‘Automatic

Temperature Setting’ to enable the single cell Peltier
accessory.

(b) Set the monitoring temperature by entering the Block
temperature as 37 °C.
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(c) In the Temperature Display group, select Probes 1 and 2
to view the temperature of two temperature Probes in
the Status Display window.

Set up instrument parameters such as wavelength, Y mode
etc.

8. Setup dialog | Cary tab
Select the Cary tab and specify the Instrument parameters for
your analysis.

(a) Enter the Wavelength and Ave (averaging) Time you
require in the corresponding entry fields.

(b) Enter an upper range and lower range value in the Y min
and Y max entry fields to specify the displayed ordinate
range.

Set up rate parameters such as the number of different rates
in the reaction, the speed and duration of the data collection

9. To set up different data collection procedures the multiple
rates in your reaction:
(a) Select the Advanced Collect radio button in the Collect

Timing group.

✒ Note The Advanced Collect facility enables you to collect data more
frequently during the crucial stages of your reaction and to collect
data less frequently where you know there will not be much
activity.

(b) Enter the number of different reaction rates that you
require in the Number of Stages entry field. The number
you set here will be reflected in the table below.

(c) Specify how long the Cary will wait after reading each
cell before it starts another reading cycle by setting the
Cycle time for each rate Stage.

(d) Specify the duration of the measurement run by setting
the Stop time for each rate Stage.

Set up collection display options

10. Setup dialog | Options tab:
(a) Select the Options tab to select the way in which you

want the data displayed as it is collected.
(b) Choose the Individual Data radio button to display the

collected data of each sample in individual graph boxes.
Choose the Overlay Data radio button to superimpose
the collected data of each sample in the run in one graph
box.
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Set up V0 calculation

11. Setup dialog | Analyze tab
(a) Select the Analyze tab.
(b) Set up the Start and Stop times for your V0 Calculation.
(c) Enter the correct product absorptivity for your reaction.
(d) Enter the correct cell pathlength for your reaction..

Set up calculations for the maximum rate ( Vmax) and
substrate concentration that gives half the maximum rate
(Km)

12. To set up Vmax and Km calculations:
(a) Select the method by which the data obtained from your

selection in the Plot/Fit group will be calculated. Choose
Linear Least Square or Marquardt by selecting the
appropriate radio button.

(b) Choose the inhibitor model for your analysis. Select
either the Non Competitive, Competitive or
Uncompetitive radio button.

(c) Check the box/es beside the Plot/Fit type/s that will be
used to determine Vmax and Km values.

(d) Select the Auto Calculate checkbox to automatically
perform enzyme kinetics calculations on collected data
at the end of each run. These results will be displayed in
the Report area.

Set up reporting and printing requirements

13. Setup dialog | Reports tab
(a) Select the Reports tab.
(b) Enter your name in the Name entry field.
(c) Enter a comment relating to your experiment in the

Comment entry field.
(d) Set up your report style by selecting the appropriate

checkboxes in the Options group.
For example, select the Auto Print checkbox to obtain a
printout of your report automatically.
Select the Parameters checkbox to include your
experimental parameters in the report.
Select the Graph checkbox to include a graph in the
generated report.
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✒ Note If Auto Print is selected, then the system will send the report
information to the specified printer as well as to the Report area.
However if Auto Print is not selected, the report will only be sent to
the Report area and can be viewed by selecting the Report option
in the View menu.

(e) Select the Autoconvert option you require.
If you choose Select for ASCII (csv) or Select for ASCII
(csv) with Log, then at the end of the data collection the
system will automatically generate a report and store the
data both in the Cary format as well as ASCII XY pairs
format in the current folder.

Set up storage of collected data

14. Setup dialog | Auto Store tab
(a) Select the Auto Store tab to set up whether the collected

data is to be saved, and if so, when the Cary should
store the information.

(b) Select Storage On (Prompt at Start), to set up the Cary
to prompt you for file name before the start of an
Enzyme Kinetics reaction.

Set up visual system monitoring

15. Select the Show Status Display checkbox on any of the tabs
to display various information fields on your current reaction.

Finish setup

16. Click “OK” to save any changes you have made and close the
Setup dialog.

Zero the instrument

17. To zero the instrument:
(a) Click the “Zero” button to zero the system. Alternatively,

select Zero in the Commands menu to perform a zero. A
Loading Guide dialog box will be displayed.

(b) If you want, change the names of the blank sample.
(c) Place the blank solution in the correct cell position and

click “OK”.
The system will perform an instrument zero on the blank
solution.
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Start the run

18. To start the run:
(a) Press the “Start” button to start a data collection.

Alternatively you can select Start in the Commands
menu. Do not add your active reagent at this time. The
system will display a Loading Guide dialog box.

(b) If you want, change the names of the sample.
(c) Place the sample solution in the correct cell position and

click “OK”.
The system will set up the Graphics area and then
display the Save As dialog box.

(d) Enter the file name for this run in the File name field and
press “Save”.
The Sync Start dialog box will appear.

(e) Add your active reagent just before the Count Down
reaches 0:00 or commence the data collection by
pressing the “OK” button.

Enter substrate and inhibitor concentrations

19. Once the run has started, enter the substrate and inhibitor
concentrations.

✒ Note If no information has been entered in the User Data Form during
the collect, no calculation is performed.

(a) Open the User Data Form, by right clicking in a graph
box and selecting User Data Form from the list or by
selecting it from the Graph menu.

(b) The table that appears has Data Names and may have
V0 values already entered in the first two columns. In the
third and fourth columns, enter your values for [S] and [I]
in µmolar/L.

(c) Press “OK”. Your [S] and [I] values are now ready to be
used in calculations, and the Cary will perform the
calculations at the end of the run.

4.5 Fabric Protection
The following Fabric Protection How to… procedure is described:

❑ How to perform a scan using the Cary 100/300/400/500
(Australian/New Zealand Standard)
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4.5.1 How to perform a scan using the Cary
100/300/400/500
(Australian/New Zealand Standard)

1. Under the Options menu, select Australian and the number of
samples to be tested.

2. Click on the “Sample Info.” button. Enter all relevant
information in the Sample Info. dialog and click “OK”.

3. Select the Setup menu to display the Setup dialog.
Select 'Report Graph' if you want the trace(s) to be displayed
in the report.
Select 'Report XY Table' for XY pairs data to be displayed in
the report.
Select 'Storage on (prompt at start)' to save the data.

4. Click on the “Baseline” button and follow the message
prompts to collect 100%T and 0%T baseline scans.

Scanning Sample 1

5. First measurement (Position 1, 0°):
(a) Click the “Scan” button. You will be prompted to select

your data saving options.
(b) Select a file name and file type and click “Save”. A dialog

will appear indicating the International Standard as well
as the sample and measurement number. You will be
prompted to place your sample at 0° (Position 1). You
also have the option of changing the name of the scan.

(c) To test the fabric sample, slide the Fabric holder out of
the accessory and place the sample into the Fabric
holder.

(d) Slide the holder back into position, replace the covers
and click “OK” to perform the test.

6. Second measurement (Position 2, 90°):
(a) A dialog like the previous will appear indicating the new

measurement number for Sample 1. You will be
prompted to place your sample at 90° (Position 2). You
also have the option of changing the name of the scan.

(b) To test the sample in position 2, slide the Fabric holder
out of the accessory and turn the sample 90° from the
original measurement position.

(c) Slide the fabric holder back into position, replace the
covers and click “OK” to perform the test.

7. This process will continue until the number of samples
selected from the Options menu in Step 1 have been
scanned.
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4.6 Kinetics
The following Kinetics How to… procedures are described:

❑ How to perform a multi-wavelength, single cell, single rate
Kinetics run (Cary 100–500).

❑ How to perform a temperature controlled Kinetics run using
the Multicell Holder (Cary 100–500)

❑ How to perform a temperature controlled Kinetics run (Cary
50)

4.6.1 How to perform a multi-wavelength, single
cell, single rate Kinetics run (Cary 100–500)

This demonstrates how to perform a multi-wavelength, single cell
Kinetics run at ambient temperature (Cary 100, 300, 400 and 500).

Start the Kinetics application

1. On the Windows Taskbar, click “Start” to display the Start
menu.

2. Move the cursor over the Programs menu item to display the
Programs menu.

3. Select Kinetics in the Cary WinUV menu.
4. Select your instrument type (if necessary) and press “OK” to

open the Kinetics application.
(Alternatively, you can double click on the Kinetics icon in the
Cary WinUV folder on the desktop.)

✒ Note If you are running a GLP system, you may be prompted to enter a
password before accessing the Kinetics application.

Set up data collection parameters

5. Setup dialog
Click the “Setup…” button or select Setup from the Menu line
to display the Setup dialog box and specify the method
parameters for a new method.

To do this:



Cary WinUV

4-36

Set up instrument parameters such as wavelength, spectral
bandwidth, Y mode etc.

6. Setup dialog | Cary tab
(a) Select the Cary tab.
(b) In the Wavelength field enter the wavelengths that you

want monitored.
(c) In the SBW field enter the required spectral bandwidth.
(d) In the Ave Time field enter the required value.
(e) Select the ordinate mode you require. Click “Abs” to

specify the Absorbance mode or “%T” to specify percent
Transmittance.

(f) Enter an upper range and lower range value in the Y min
and Y max entry fields to specify the displayed ordinate
range.

(g) Select the abscissa (X) mode you require. Click “Min” to
time in minutes or “Sec” to time in seconds.

Set up rate parameters such as the number of different rates
in the reaction, the speed, and the duration of the data
collection

7. Setup dialog | Cary tab
(a) Select the ‘Simple Collect’ radio button in the Collect

Timing group. This sets up a single rate for your
reaction.

(b) Specify how long the Cary will wait after reading each
cell before it starts another reading cycle by setting the
Cycle time.

(c) Specify the duration of the Kinetics run by setting the
Stop time.

Set up lamp and graphics options

8. Setup dialog | Options tab
(a) Select the Options tab.
(b) Check the ‘Auto Lamps Off’ checkbox if you want to

automatically turn off the lamps at the end of a collect.
This option enables you to preserve the lifetime of the
lamps. It is especially useful for when performing
Kinetics data collections overnight or unattended for long
periods of time.

(c) Click on the ‘UV/Vis’ radio button if you want both the
lamps on during the run.

(d) Enter your required Source Changeover and Detector
Changeover (Cary 500 only) wavelengths in the
corresponding entry fields.
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(e) Set the monochromator exit slit height to full or reduced
(Cary 400 and 500 only).

(f) In the Display Options group, select the way in which
you want the data displayed as it is collected. Choose
the ‘Individual Data’ radio button to display the collected
data of each sample in individual graph boxes. Choose
the ‘Overlay Data’ radio button to superimpose the
collected data of each sample in the Kinetics run in one
graph box.

Set up accessories

9. Setup dialog | Accessories tab
Select the Accessories tab and ensure that no
Accessories are selected.

Set up rate calculation, rate order and other rate parameters

10. Setup dialog | Analyze tab
(a) Select the Analyze tab.
(b) Select the ‘Auto Calculate’ checkbox to automatically

perform a rate calculation on collected data at the end of
each run.

(c) Select ‘Simple Calculate’ to setup one rate calculation
for the entire Kinetics run.

(d) Set up the reaction Start and Stop times and select the
reaction order.

(e) If you select a 'first order' or 'second order' Simple
Calculate rate calculation you can use the Manual
Guess group to manually enter the parameters: A0, AInf
and Rate (k). It is presumed that you have a reasonable
idea of the values for these fit parameters, as they will
be used as a first guess for the Marquardt non-linear
regression analysis.

✒ Note If you do not choose ‘Manual Guess’ then the Cary system will
automatically calculate the values: A0, AInf and Rate when the
“Start” button is pressed.

(f) Enter a value in the Factor field to calculate enzyme
activity. The numerical multiplication factor is applied to
the absorbance.
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(g) If you are performing a second order reaction, enter the
initial concentration of substrate before reaction.

(h) Select ‘Display Fit’ to automatically overlay the
calculated lines of best fit onto the plotted data.

Set up reporting and printing requirements

11. Setup dialog | Reports tab
Select the Reports tab and specify your reporting
requirements for this method.

(a) Enter your name in the Name entry field.
(b) Enter a comment relating to your experiment in the

Comment entry field.
(c) Set up your report style by selecting the appropriate

checkboxes in the Options group.
For example, select the ‘Auto Print’ checkbox to obtain a
printout of your report automatically.
Select the ‘Parameters’ checkbox to include your
experimental parameters in the report. Select the ‘Graph’
checkbox to include a graph in the generated report.

✒ Note If ‘Auto Print’ is selected, then the system will send the report
information to the specified printer as well as the Report area.
However, if ‘Auto Print’ is not selected, the report will only be sent
to the Report area and can be viewed by selecting Report in the
View menu.

(d) Check Include X-Y Pairs Table to view a list of abscissa
values and their corresponding ordinate values.

(e) Select the Autoconvert option you require. If you select
‘ASCII’ or ‘ASCII with Log’, then at the end of the data
collection the system will automatically generate a report
and store the data both in the Cary format as well as
ASCII XY pairs format in the current folder.

Set up storage of collected data

12. Setup dialog | Auto Store tab
(a) Select the ‘Auto Store’ tab to set up whether the

collected data is to be saved, and if so, when the Cary
should store the information.

(b) Select ‘Storage Off’. The method, collected data and
report will not be saved.
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Set up visual system monitoring

13. Select the ‘Show Status Display’ checkbox to display various
information fields on your current reaction.

Finish setup

14. Once you are satisfied with your method setup click “OK” to
confirm any changes you have made and close the Setup
dialog.

Zero the instrument

15. To zero the instrument:
(a) Click the “Zero” button to zero the system. Alternatively,

select Zero in the Commands menu to perform a zero. A
Loading Guide dialog box will be displayed.

(b) If you want, change the name of the blank.
(c) Place the blank solution in the sample compartment and

click “OK”.
The system will perform an instrument zero on the blank
solution(s).

Start the Kinetics run

16. To start the Kinetics run:
(a) Press the application “Start” button to start a data

collection. Alternatively, you can select Start in the
Commands menu. Do not add your active reagent at this
time. The system will display a Loading Guide dialog
box.

(b) If you want, change the names of the sample.
(c) Place the sample solution in the front cell holder and

click “OK”. The system will set up the Graphics area and
then display Sync Start dialog box.

(d) Add your active reagent just before the Count Down
reaches 0:00 or commence the data collection by
pressing the “OK” button.
The Cary will start the data collection.
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Save your data

17. To save your data:
(a) Click on the File menu and select Save Data As.
(b) Enter the file name for this Kinetics run in the File name

field.
(c) Press “Save”.

The data will be stored as a Batch file.

4.6.2 How to perform a temperature controlled
Kinetics run using the Multicell Holder
(Cary 100–500)

This demonstrates how to perform a multicell, multi-rate Kinetics
run at 37 °C using the Temperature Controller accessory with the
Multicell Holder accessory (Cary 100, 300, 400 and 500).

Start the Kinetics application

1. On the Windows Taskbar, click “Start” to display the Start
menu.

2. Move the cursor over the Programs menu item to display the
Programs menu.

3. Select Kinetics in the Cary WinUV menu.
4. Select your instrument type (if necessary) and press “OK” to

open the Kinetics application.
(Alternatively, you can double click on the Kinetics icon in the
Cary WinUV folder on the desktop.)

✒ Note If you are running a GLP system, you may be prompted to enter a
password before accessing the Kinetics application.

Set up data collection parameters

5. Setup dialog
Click the “Setup…” button or select Setup from the Menu line
to display the Setup dialog box and specify the method
parameters for a new method.

To do this:

Set up Multicell Holder accessory with multi zero

6. Setup dialog | Accessories tab
As various options do not become available until the
appropriate accessories are selected, you need to select
these first.
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(a) Select the Accessories tab.
(b) Select the ‘Use Cell Changer’ checkbox to enable the

accessory.
(c) For Cary 100/300 instruments, choose the type of

Multicell Holder you are using (6 x 6 or 8 x 6).
(d) Ensure that you have this accessory installed prior to

commencing the run.
(e) Choose the ‘Select Cells’ radio button and select the

cells you require from the available cells in the Use Cells
group.
For Front Beam analysis, select the checkboxes Cell 1
to Cell 6 (6 x 6) or Cell 1 to Cell 8 (8 x 6). This will
ensure that all front cell positions in the Multicell Holder
will be measured during your Kinetics analysis.

(f) Check the ‘Multi Zero’ checkbox to turn on the Multi Zero
facility.

(g) Ensure that the Blank Correction checkbox is not
checked.

Set up accessories for reaction temperature control and
temperature display

7. Setup dialog | Accessories tab
(a) If you are not using a Peltier controlled accessory (e.g.

the water thermostatted 8 x 6) ensure that you have the
Temperature Controller accessory installed prior to
commencing the run, and,

(i) Select ‘Automatic Temperature Setting’ and
select the Temperature Controller to enable the
accessory.

(ii) Set the monitoring temperature by entering the
Block temperature as ‘36 °C’. (The monitoring
device is selected in step 8 part (e)).

(b) In the Temperature Display group, select ‘Block’ and
‘Probe 1’ to turn on monitoring of the Multicell Holder
block and one temperature Probe.

Set up instrument parameters such as wavelength, spectral
bandwidth, Y mode etc.

8. Setup dialog | Cary tab
Select the Cary tab and specify the instrument parameters for
your analysis.

(a) Enter the Wavelength, SBW and Ave (averaging) Time
you require in the corresponding entry fields.
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(b) Select the ordinate mode you require. Click “Abs” to
specify the Absorbance mode or “%T” to specify percent
Transmittance.

(c) Enter an upper range and lower range value in the Y min
and Y max entry fields to specify the displayed ordinate
range.

(d) Select the abscissa (X) mode you require. Click “Min” to
time in minutes or “Sec” to time in seconds.

(e) Choose the desired temperature monitoring device in the
Monitor field. The “Start” button will not be enabled until
the temperature of the selected Monitor is within 0.5 °C
of the Block temperature set in the Accessories tab.
(Step 7 part (a)(ii)).

Set up instrument parameters such as wavelength, spectral
bandwidth, Y mode etc.

9. Setup dialog | Cary tab
Select the ‘Advanced Collect’ radio button in the Collect
Timing group. This enables you to set up different data
collection procedures for the multiple rates in your reaction.

✒ Note The ‘Advanced Collect’ facility enables you to collect data more
frequently during the crucial stages of your kinetics reaction and to
collect data less frequently where you know there will not be much
activity.

(a) Enter the number of different reaction rates that you
require in the Number of Stages entry field. The number
you set here will be reflected in the table below this field.

(b) Vary the number of data points collected per cell, per run
by setting the Dwell time for each rate Stage.

(c) Specify how long the Cary will wait after reading each
cell before it starts another reading cycle by setting the
Cycle time for each rate Stage.

(d) Specify the duration of the Kinetics run by setting the
Stop time for each rate Stage.
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Set up lamp and graphics options

10. Setup dialog | Options tab
(a) Select the Options tab.
(b) Check the ‘Auto Lamps Off’ checkbox if you want to

automatically turn off the lamps at the end of a collect.
This option enables you to preserve the lifetime of the
lamps. It is especially useful for when performing
Kinetics data collections overnight or unattended for long
periods of time.

(c) Click on the ‘UV/Vis’ radio button if you want both the
lamps on during the run.

(d) Enter your required Source Changeover and Detector
Changeover (Cary 500 only) wavelengths in the
corresponding entry fields.

(e) Set the monochromator exit slit height to full or reduced
(Cary 400 and 500 only).

(f) In the Display Options group, select the way in which
you want the data displayed as it is collected. Choose
the ‘Individual Data’ radio button to display the collected
data of each sample in individual graph boxes. Choose
the ‘Overlay Data’ radio button to superimpose the
collected data of each sample in the Kinetics run in one
graph box.

Set up rate calculation, rate order and other rate parameters

11. Setup dialog | Analyze tab
(a) Select the Analyze tab.
(b) Select the ‘Auto Calculate’ checkbox to automatically

perform a rate calculation on collected data at the end of
each run.

(c) Select ‘Advanced Calculate’ to set up multiple rate
calculations for the Kinetics run.

(d) Enter the number of different rate calculations that you
require in the Number of Stages entry field. The number
you set here will be reflected in the table below.

(e) Set up the Stage Start and Stop times and select the
reaction order for each of these reaction stages.
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✒ Note If you select a ‘first order’ or ‘second order’ Simple Calculate rate
calculation, you can use the Manual Guess group to manually
enter the parameters: A0, Ainf and Rate (k). It is presumed that
you have a reasonable idea of the values for these fit parameters,
as they will be used as a first guess for the Marquardt non–linear
regression analysis.

(f) Enter a value in the Factor field to calculate enzyme
activity. The numerical multiplication factor is applied to
the absorbance.

(g) If you are performing a second order reaction, enter the
initial concentration of substrate before reaction.

(h) Select ‘Display Fit’ to automatically overlay the
calculated lines of best fit onto the plotted data.

Set up reporting and printing requirements

12. Setup dialog | Reports tab
(a) Select the Reports tab.
(b) Enter your name in the Name entry field.
(c) Enter a comment relating to your experiment in the

Comment entry field.
(d) Set up your report style by selecting the appropriate

checkboxes in the Options group. For example, select
the ‘Auto Print’ checkbox to obtain a printout of your
report automatically.
Select the ‘Parameters’ checkbox to include your
experimental parameters in the report. Select the ‘Graph’
checkbox to include a graph in the generated report.

✒ Note If ‘Auto Print’ is selected, then the system will send the report
information to the specified printer as well as to the Report area.
However if ‘Auto Print’ is not selected, the report will only be sent
to the Report area and can be viewed by selecting Report in the
View menu.

(e) Check Include X-Y Pairs Table to view a list of abscissa
values and their corresponding ordinate values.

(f) Select the Autoconvert option you require. If you select
‘ASCII’ or ‘ASCII with Log’, then at the end of the data
collection the system will automatically generate a report
and store the data both in the Cary format as well as
ASCII XY pairs format in the current folder.
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Set up storage of collected data

13. Setup dialog | Auto Store tab
(a) Select the Auto Store tab to set up whether the collected

data is to be saved, and if so, when the Cary should
store the information.

(b) Select ‘Storage On (Prompt at Start)’, to set up the Cary
to prompt you for a file name before the start of a
Kinetics reaction.

Set up visual system monitoring

14. Select the ‘Show Status Display’ checkbox to display various
information fields on your current reaction.

Finish setup

15. Click “OK” to save any changes you have made and close the
Setup dialog.

Zero the instrument

16. To Zero the instrument:
(a) Click the “Zero” button to zero the system. Alternatively,

select Zero in the Commands menu to perform a zero. A
Cell Loading Guide dialog box will be displayed.

(b) If you want, change the names of the blank samples.
(c) Place the blank solution(s) in the correct cell positions

and click “OK”. The system will perform an instrument
zero on the blank solution(s).

Start the Kinetics run

17. To start the Kinetics run:
(a) Press the application “Start” button to start a data

collection. Alternatively, you can select Start in the
Commands menu. Do not add your active reagent at this
time. The system will display the Save As dialog box.

(b) Enter the file name for this Kinetics run in the File name
field and press “Save”. The system will display a Cell
Loading Guide box.

(c) If you want, change the names of the samples.
(d) Place the sample solution(s) in the correct cell positions

and click “OK”. The system will set up the Graphics area
and then the Sync Start dialog box will appear.
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(e) Reset the Multicell Holder to position to cell 1 using the
“Reset Slide” button.

(f) Add your active reagent just before the Count Down
reaches 0:00, or commence the data collection by
pressing the “OK” button.

4.6.3 How to perform a temperature controlled
Kinetics run (Cary 50)

This demonstrates how to perform a single cell, multi-rate Kinetics
run at 37 °C using the single cell Peltier accessory (Cary 50).

Start the Kinetics application

1. On the Windows Taskbar, click “Start” to display the Start
menu.

2. Move the cursor over the Programs menu item to display the
Programs menu.

3. Select Kinetics in the Cary WinUV menu.
4. Select your instrument type (if necessary) and press “OK” to

open the Kinetics application.
(Alternatively, you can double click on the Kinetics icon in the
Cary WinUV folder on the desktop.)

✒ Note If you are running a GLP system, you may be prompted to enter a
password before accessing the Kinetics application.

Set up data collection parameters

5. Setup dialog
Click the “Setup…” button or select Setup from the Menu line
to display the Setup dialog box and specify the method
parameters for a new method.

To do this:

Ensure Multicell Holder accessory is not selected

6. Setup dialog | Accessories tab
As various options do not become available until the
appropriate accessories are selected, you need to select
these first.

(a) Select the Accessories tab.
(b) Ensure the Use Cell Changer checkbox is not selected.
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Set up accessories for reaction temperature control and
temperature display

7. Setup dialog | Accessories tab
(a) In the Temperature group, check Automatic

Temperature setting to enable the single cell Peltier
accessory.

(b) Set the monitoring temperature by entering the Block
temperature as 37 °C.

(c) In the Temperature Display group, select Probe 1 to
view the temperature of one temperature probe in the
Status Display window.

Set up instrument parameters such as wavelength, average
time, X mode etc.

8. Setup dialog | Cary tab
(a) Select the Cary tab
(b) In the Wavelength field enter the wavelengths that you

want monitored.
(c) Enter an upper range and lower range value in the Y min

and Y max entry fields to specify the displayed ordinate
range.

(d) Select the abscissa (X) mode you require. Click “Min” to
time in minutes of “Sec” to time in seconds.

Set up rate parameters such as the number of different rates
in the reaction, the speed, and the duration of the data
collection

9. Setup dialog | Cary tab
(a) Select the ‘Advanced Collect’ radio button in the Collect

Timing group. This enables you to set up different data
collection procedures for the multiple rates in your
reaction.

✒ Note The ‘Advanced Collect’ facility enables you to collect data more
frequently during the crucial stages of your kinetics reaction and to
collect data less frequently where you know there will not be much
activity.

(b) Enter the number of different reaction rates that you
require in the Number of Stages entry field. The number
you set here will be reflected in the table below.

(c) Specify how long the Cary will wait after reading each
cell before it starts another reading cycle by setting the
Cycle time for each rate Stage.
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(d) Specify the duration of the measurement run by setting
the Stop time for each rate Stage.

Set up collection display options

10. Setup dialog | Options tab
(a) Select the Options tab.
(b) Select the Individual Data radio button to display a

separate graph for each cell, or Overlay Data to display
all results in the one graph.

Set up rate calculation, rate order and other rate parameters

11. Setup dialog | Analyze tab
(a) Select the Analyze tab.
(b) Select the ‘Auto Calculate’ checkbox to automatically

perform a rate calculation on collected data at the end of
each run.

(c) Select ‘Advanced Calculate’ to set up multiple reaction
rate calculations for the Kinetics run.

(d) Enter the number of different rate calculations that you
require in the Number of Stages entry field. The number
you set here will be reflected in the table below.

(e) Set up the Stage Start and Stop times and select the
reaction Order for each of these reaction stages.

✒ Note If you select a ‘first order’ or ‘second order’ Simple Calculate rate
calculation, you can use the Manual Guess group to manually
enter the parameters: A0, Ainf and Rate (k). It is presumed that
you have a reasonable idea of the values for these fit parameters,
as they will be used as a first guess for the Marquardt non–linear
regression analysis.

If you do not choose Manual Guess then the Cary
system will automatically calculate the A0, AInf and Rate
values when the “Start” button is pressed.

(f) Enter a value in the Factor field to calculate enzyme
activity. The numerical multiplication factor is applied to
the absorbance.

(g) If you are performing a second order reaction, enter the
initial concentration of substrate before reaction.

(h) Select ‘Display Fit’ to automatically overlay the
calculated lines of best fit onto the plotted data.
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Set up reporting and printing requirements

12. Setup dialog | Reports tab
(a) Select the Reports tab.
(b) Enter your name in the Name entry field.
(c) Enter a comment relating to your experiment in the

Comment entry field.
(d) Set up your report style by selecting the appropriate

checkboxes in the Options group.
For example, select the ‘Auto Print’ checkbox to obtain a
printout of your report automatically. Select the
‘Parameters’ checkbox to include your experimental
parameters in the report. Select the ‘Graph’ checkbox to
include a graph in the generated report.

✒ Note If ‘Auto Print’ is selected, then the system will send the report
information to the specified printer as well as the Report area.
However, if ‘Auto Print’ is not selected, the report will only be sent
to the Report area and can be viewed by selecting the Report
option in the View menu.

(e) Check Include X-Y Pairs Table to view a list of abscissa
values and their corresponding ordinate values.

(f) Select the Autoconvert option you require. If you select
‘ASCII’ or ‘ASCII with Log’, then at the end of the data
collection the system will automatically generate a report
and store the data both in the Cary format as well as
ASCII XY pairs format in the current folder.

Set up storage of collected data

13. Setup dialog | Auto Store tab
(a) Select the Auto Store tab to set up whether the collected

data is to be saved, and if so, when the Cary should
store the information.

(b) Select ‘Storage On (Prompt at Start)’ to set up the Cary
to prompt you for a file name before the start of a
Kinetics run.

Set up visual system monitoring

14. Select the ‘Show Status Display’ checkbox to display various
information fields on your current reaction.
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Finish setup

15. Once you are satisfied with your method setup, click OK to
confirm any changes you have made and close the Setup
dialog.

Zero the instrument

16. To Zero the instrument:
(a) Click the “Zero” button to zero the system. Alternatively,

select Zero in the Commands menu to perform a zero. A
Loading Guide dialog box will be displayed.

(b) If you want, change the name of the blank.
(c) Place the blank solution in the sample compartment and

click “OK”.
The system will perform an instrument zero on the blank
solution.

Start the Kinetics run

17. To start the Kinetics run:
(a) Press the application “Start” button to start a data

collection. Alternatively, you can select Start in the
Commands menu. Do not add your active reagent at this
time. The system will display the Save As dialog box.

(b) Enter the file name for this Kinetics run in the File name
field and press “Save”. The system will display a Loading
Guide dialog box.

(c) If you want, change the name of the sample.
(d) Place the sample solution in the correct position and

click “OK”. The system will set up the Graphics area and
then display Sync Start dialog box.

(e) Add your active reagent just before the Count Down
reaches 0:00 or commence the data collection by
pressing the “OK” button.

4.7 RNA/DNA
The following RNA/DNA How to… procedures are described:

❑ How to perform a temperature controlled run using the
Multicell Holder (Cary 100–500)

❑ How to perform a run using the Multicell Holder (Cary 50)
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4.7.1 How to perform a temperature controlled
run using the Multicell Holder (Cary 100–
500)

This demonstrates how to perform a multicell RNA-DNA run with
multi zero and multi baseline at 37 °C using the Temperature
Controller accessory with the Multicell Holder accessory (Cary 100,
300, 400 and 500).

Start the RNA-DNA application

1. On the Windows Taskbar, click “Start” to display the Start
menu.

2. Move the cursor over the Programs menu item to display the
Programs menu.

3. Select RNA - DNA in the Cary WinUV menu.
4. Select your instrument type (if necessary) and press “OK” to

open the RNA-DNA application.
(Alternatively, you can double click on the RNA-DNA
icon in the Cary WinUV folder on the desktop.)

✒ Note If you are running a GLP system, you may be prompted to enter a
password before accessing the RNA-DNA application.

Set up data collection parameters

5. Setup dialog
Click the “Setup…” button or select Setup from the Menu line
to display the Setup dialog box and specify the method
parameters for a new method.

To do this:

Set up Multicell Holder accessory with multi zero

6. Setup dialog | Accessories 1 tab
As various options do not become available until the
appropriate accessories are selected, you need to select
these first.

(a) Select the Accessories 1 tab.
(b) Select the Use Cell Changer checkbox to enable the

accessory.
(c) For Cary 100/300 instruments, choose the type of

Multicell Holder you are using (6 x 6 or 8 x 6).
(d) Ensure that you have this accessory installed prior to

commencing the run.
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(e) Choose the Select Cells radio button and select the cells
you require from the available cells in the Use Cells
group.
For double beam analysis, select the checkboxes Cell 1
through to the Cell 6 (6 x 6) or Cell 1 through 8 (8 x 6).

(f) Check the Multi Zero checkbox to turn on the Multi Zero
facility.
The Multi Baseline facility will not be accessible until
completing Step 8.

Set up accessories for reaction temperature control and
temperature display

7. Setup dialog | Accessories 1 tab
(a) If you are not using a Peltier controlled accessory (e.g.

the water thermostatted 8 x 6) ensure that you have the
Temperature Controller accessory installed prior to
commencing the run, and,

(i) Tick Automatic Temperature Setting and select
the Temperature Controller to enable the accessory.

(ii) Set the monitoring temperature by entering the
Block temperature as 37 °C. (The monitoring device
is selected in Step 8 part (d)).

(b) In the Temperature Display group, select Block and
Probe 1 to view the temperature of the Multicell Holder
block and one temperature Probe in the Status Display
window.

Set up instrument parameters such as wavelength, etc.

8. Setup dialog | Cary and Baseline tabs
(a) Select the Cary tab.
(b) Enter the first and second wavelengths at which you

would like to measure your sample/s.
(c) If you require background correction, select the

Background Correction checkbox and enter a
background wavelength in the corresponding field.

(d) Choose the desired temperature monitoring device in the
Monitor field. The “Start” button will not be enabled until
the temperature of the selected Monitor is within 0.5 °C
of the Block temperature set in the Accessories 1 tab
(Step 7 part (a)(ii)).
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(e) To perform a wavelength scan, check ‘Scan Samples’.
The Baseline tab will appear. Make your Wavelength
Scan selections on the Cary tab, then select the
Baseline tab.

(f) Select ‘Baseline correction’. To use a previously stored
baseline (*.CDN), click on the “Baseline…” button and
browse for the appropriate file. Otherwise, you can
perform your baseline correction at the beginning of the
run.To perform a Multi Baseline, you can now go back to
the Accessories 1 tab and check the Multi Baseline
checkbox which will now be activated.

Set up source, SBW and display options

9. Setup dialog | Options tab
(a) Select the Options tab.
(b) Check the Auto Lamps Off checkbox if you want to

automatically turn off the lamps at the end of a collect.
This option enables you to preserve the lifetime of the
lamps. It is especially useful for when performing data
collections overnight or unattended for long periods of
time.

(c) Click on the UV/Vis radio button if you want both the
lamps on during the run.

(d) Enter your required Source Changeover and Detector
Changeover (Cary 500 only) wavelengths in the
corresponding entry fields.

(e) Enter the spectral bandwidth of your instrument in the
SBW field.

(f) Set the appropriate Slit Height (Cary 400/500 only).
(g) In the Display Options group, select the way in which

you want the data displayed as it is collected. Choose
the Individual Data radio button to display the collected
data of each sample in individual graph boxes. Choose
the Overlay Data radio button to superimpose the
collected data of each sample in the run in one graph
box.

Set up samples and increment names

10. Setup dialog | Samples tab
(a) Select the Samples tab. This tab allows you to enter a

list of sample names that will be used during your
analysis.
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(b) Enter the number of samples that you are going to use in
the Number of Samples field. The Sample Names list
below will expand or contract to match your choice.

(c) In the Sample Names list, enter the name of each
sample. You can enter up to 20 characters for each
name.

(d) De-select the samples that you do not wish to analyze
by clicking beside the desired sample in the small first
column to remove the red tick.

(e) If the samples have the same name with a different
numeric extension, enter the name in the first sample
position and then press the “Increment” button.

(f) If you would like multiple readings of the same aliquot,
select the Replicates checkbox and enter the number of
replicates required in the data entry field that appears.

Set up analysis parameters

11. Setup dialog | Analyze tab
Select the Analyze tab. If you would like to calculate any
Warburg Christian or 260 nm Factor parameters, make your
selections here.

Set up reporting and printing requirements

12. Setup dialog | Reports tab
(a) Select the Reports tab.
(b) Enter your name in the Name entry field.
(c) Enter a comment relating to your experiment in the

Comment entry field.
(d) Set up your report style by selecting the appropriate

checkboxes in the Options group.
For example, select the Auto Print checkbox to obtain a
printout of your report automatically.
Select the Parameters checkbox to include your
experimental parameters in the report.
If you have selected ‘Scan Samples’ on the Cary tab,
select the Graph checkbox to include a graph in the
generated report.

✒ Note If Auto Print is selected, then the system will send the report
information to the specified printer as well as to the Report area.
However if Auto Print is not selected, the report will only be sent to
the Report area and can be viewed by selecting the Report option
in the View menu.

(e) Select the Autoconvert option you require.
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If you choose Select for ASCII (csv) or Select for ASCII
(csv) with Log, then at the end of the data collection the
system will automatically generate a report and store the
data both in the Cary format as well as ASCII XY pairs
format in the current folder.

Set up storage of collected data

13. Setup dialog | Auto Store tab
(a) Select the Auto Store tab to set up whether the collected

data is to be saved, and if so, when the Cary should
store the information.

(b) Select Storage On (Prompt at Start), to set up the Cary
to prompt you for a file name before the start of an RNA-
DNA run.

Set up visual system monitoring

14. Select the Show Status Display checkbox on any of the tabs
to display various information fields on your current reaction.

Finish setup

15. Click “OK” to save any changes you have made and close the
Setup dialog.

Zero the instrument

16. To zero the instrument:
(a) Click the “Zero” button to zero the system. Alternatively,

select Zero in the Commands menu to perform a zero. A
Cell Loading Guide dialog box will be displayed.

(b) Place the blank solution(s) in the correct cell positions
and click “OK”.
The system will perform an instrument zero on the blank
solution(s).

✒ Note If you have chosen not to use the Multi Zero facility in Step 7 part
(e), the system will prompt you to enter one blank solution into the
instrument. In this case, it is important to ensure that you place this
blank solution in the cell position that is currently in the light path.
On pressing “OK”, the system will perform a zero on the cell
position in the light path, i.e. the system will not reset the Multicell
Holder to position 1.
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Perform a baseline correction (if not using a stored baseline)

17. If you have selected to perform a baseline correction (Step
8(f)) and are not using a stored baseline, take a baseline
reading now by following the steps below. Otherwise, proceed
to Step 18.
(a) Click the “Baseline” button. A Cell Loading Guide dialog

box will appear.
(b) Load the blank/s as depicted.
(c) Click “OK”. The system will collect a baseline for each

cell in use and the word ‘baseline’ will appear above the
ordinate instrument status reading.

Start the RNA-DNA run

18. To start the run:
(a) Press the “Start” button to start a data collection.

Alternatively you can select Start in the Commands
menu. The system will display the Save As dialog box.

(b) Enter the file name for this RNA-DNA run in the File
name field and press “Save”. The system will display a
Cell Loading Guide dialog box.

(c) Place the sample solution(s) in the correct cell positions
and click “OK”. The system will then begin reading the
samples and printing the results to the Report area.

4.7.2 How to perform a run using the Multicell
Holder (Cary 50)

This demonstrates how to perform a multicell wavelength scan with
baseline correction, multi zero and multi baseline (Cary 50).

Start the RNA-DNA application

1. On the Windows Taskbar, click “Start” to display the Start
menu.

2. Move the cursor over the Programs menu item to display the
Programs menu.

3. Select RNA - DNA in the Cary WinUV menu.
4. Select your instrument type (if necessary) and press “OK” to

open the RNA-DNA application.
(Alternatively, you can double click on the RNA-DNA icon in
the Cary WinUV folder on the desktop.)

✒ Note If you are running a GLP system, you may be prompted to enter a
password before accessing the RNA-DNA application.
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Set up data collection parameters

5. Setup dialog
Click the “Setup…” button or select Setup from the Menu line
to display the Setup dialog box and specify the method
parameters for a new method.

To do this:

Set up instrument parameters such as wavelength, etc.

6. Setup dialog | Cary and Baseline tabs
(a) Select the Cary tab.
(b) Enter the first and second wavelengths at which you

would like to measure your sample.
(c) If you require background correction, select the

Background Correction checkbox and enter a
background wavelength in the corresponding field.

(d) If you are performing a wavelength scan, check ‘Scan
Samples’. The Display Options group will be activated
and the Baseline tab will appear.

(e) Enter a Start and Stop wavelength value and select a
Scan Rate.

(f) In the Display Options group, select the way in which
you want the data displayed as it is collected.
Choose the Individual Data radio button to display the
collected data of each sample in individual graph boxes.
Choose the Overlay Data radio button to superimpose
the collected data of each sample in the run in one graph
box.

(g) Select the Baseline tab and check ‘Baseline correction’.
(h) To use a previously stored baseline (*.CDN), click on the

“Baseline…” button and browse for the appropriate file.
Otherwise, you can perform your baseline correction at
the beginning of the run.

Set up Multicell Holder accessory with multi zero

7. Setup dialog | Accessories 1 tab
(a) Select the Accessories 1 tab.
(b) Select the Use Cell Changer checkbox to enable the

accessory.
(c) Ensure that you have this accessory installed prior to

commencing the run.
(d) Choose the Select Cells radio button and select the cells

you require from the available cells in the Use Cells
group.
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(e) Check the Multi Zero checkbox to turn on the Multi Zero
facility.

(f) Check Multi Baseline to turn on the Multi Baseline
facility.

Set up samples and increment names

8. Setup dialog | Samples tab
(a) Select the Samples tab. This tab allows you to enter a

list of sample names that will be used during your
analysis.

(b) Enter the number of samples that you are going to use in
the Number of Samples field. The Sample Names list
below will expand or contract to match your choice.

(c) In the Sample Names list, enter the name of each
sample. You can enter up to 20 characters for each
name.

(d) De-select any samples that you don not wish to analyze
by clicking beside the desired sample in the small first
column to remove the red tick.

(e) If the samples have the same name with a different
numeric extension, enter the name in the first sample
position and then press the “Increment” button.

(f) If you would like multiple readings of the same aliquot,
select the Replicates checkbox and enter the number of
replicates required in the data entry field that appears.

Set up analysis parameters

9. Setup dialog | Analyze tab
Select the Analyze tab. If you would like to calculate any
Warburg Christian or 260 nm Factor parameters, make your
selections here.

Set up reporting and printing requirements

10. Setup dialog | Reports tab
(a) Select the Reports tab.
(b) Enter your name in the Name entry field.
(c) Enter a comment relating to your experiment in the

Comment entry field.
(d) Set up your report style by selecting the appropriate

checkboxes in the Options group.



Cary WinUV

4-59

For example, select the Auto Print checkbox to obtain a
printout of your report automatically.
Select the Parameters checkbox to include your
experimental parameters in the report.
If you have selected ‘Scan Samples’ on the Cary tab,
select the Graph checkbox to include a graph in the
generated report.

✒ Note If Auto Print is selected, then the system will send the report
information to the specified printer as well as to the Report area.
However if Auto Print is not selected, the report will only be sent to
the Report area and can be viewed by selecting the Report option
in the View menu.

(e) Select the Autoconvert option you require.
If you choose Select for ASCII (csv) or Select for ASCII
(csv) with Log, then at the end of the data collection the
system will automatically generate a report and store the
data both in the Cary format as well as ASCII XY pairs
format in the current folder.

Set up storage of collected data

11. Setup dialog | Auto Store tab
(a) Select the Auto Store tab to set up whether the collected

data is to be saved, and if so, when the Cary should
store the information.

(b) Select Storage On (Prompt at Start), to set up the Cary
to prompt you for a file name before the start of a RNA-
DNA run.

Set up visual system monitoring

12. Select the Show Status Display checkbox on any of the tabs
to display various information fields on your current reaction.

Finish setup

13. Click “OK” to save any changes you have made and close the
Setup dialog.

Zero the instrument

14. To zero the instrument:
(a) Click the “Zero” button to zero the system. Alternatively,

select Zero in the Commands menu to perform a zero. A
Cell Loading Guide dialog box will be displayed.

(b) Place the blank solution(s) in the correct cell positions
and click “OK”.
The system will perform an instrument zero on the blank
solution(s).
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✒ Note If you have chosen not to use the Multi Zero facility in Step 7 part
(e), the system will prompt you to enter one blank solution into the
instrument. In this case, it is important to ensure that you place this
blank solution in the cell position that is currently in the light path.
On pressing OK, the system will perform a zero on the cell position
in the light path, i.e. the system will not reset the Multicell Holder to
position 1.

Collect baselines (if not using a stored baseline)

15. If you have selected to perform a baseline correction (Step
6(g)) and are not using a stored baseline, take a baseline
reading now by following the steps below. Otherwise, proceed
to Step 16.
(a) Press the “Baseline” button to collect a baseline for each

cell. A Cell Loading Guide dialog box will appear.
(b) Load the blank/s as depicted.
(c) Click “OK”. On completion of the baseline collections,

the word ‘baseline’ will appear in red above the ordinate
instrument status reading.

Start the RNA-DNA run

16. To start the run:
(a) Press the “Start” button to start a data collection.

Alternatively you can select Start in the Commands
menu. The system will display the Save As dialog box.

(b) Enter the file name for this RNA-DNA run in the File
name field and press “Save”. The system will display a
Cell Loading Guide dialog box.

(c) Place the sample solution(s) in the correct cell positions
and click “OK”. The system will then begin reading the
samples and printing the results to the Report area.

4.8 Scan
The following Scan How to… procedures are described.

❑ How to perform a scan with baseline correction (Cary 100–
500)

❑ How to perform a scan in Signal-to-Noise mode (Cary 100-
500)

❑ How to perform a scan in Independent mode (Cary 500)

❑ How to perform a scan with baseline correction (Cary 50)
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4.8.1 How to perform a scan with baseline
correction (Cary 100–500)

This demonstrates how to perform a wavelength scan from 500 nm
to 400 nm with baseline correction (Cary 100, 300, 400, 500).

Start the Scan application

1. On the Windows Taskbar, click “Start” to display the Start
menu.

2. Move the cursor over the Programs menu item to display the
Programs menu.

3. Select Scan in the Cary WinUV menu.
4. Select your instrument type (if necessary) and press “OK” to

open the Scan application.
(Alternatively, you can double click on the Scan icon in the
Cary WinUV folder on the desktop.)

✒ Note If you are running a GLP system you may be prompted to enter a
password before accessing the Scan application.

Set up data collection parameters

5. Setup dialog
Click the “Setup…” button or select Setup from the Menu line
to display the Setup dialog box and specify the method
parameters for a new method.

To do this:

Set up instrument parameters such as X Mode, Y Mode,
wavelength range etc.

6. Setup dialog | Cary tab
(a) Set the appropriate abscissa mode for the scan in the X

Mode field, for example 'nanometers'.
(b) Set the wavelength range for the scan by entering the

values you require in the Start/Stop fields, for example
‘500/400’.

(c) In the Y Mode field, select the ordinate mode in which
you want the collect data to be displayed, for example
'Abs'.

(d) Enter an upper range and lower range value in the Y min
and Y max entry fields to specify the displayed ordinate
range.
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(e) Set the speed of the data collection. With the Cary
instruments you do this by setting the Ave Time and
Data Interval. In the Ave Time field enter the required
value. A good starting value is 0.1 second.

(f) In the Data Interval field, enter the wavelength increment
you require between data points. A good starting point is
0.5. The Cary will automatically update the Scan Rate
field when you select it.

(g) Make sure that Cycle Mode is not selected.

Set up SBW, lamp and graphics options

7. Setup dialog | Options tab
(a) Select the Options tab.
(b) Set the SBW for the run. If you are using a Cary 400,

select ‘Fixed SBW’ for the run.
(c) Set the Beam Mode for the run. This is commonly set to

‘Double’.
(d) For Cary 500 do not set the Energy. The Cary will use a

fixed SBW for the run and will alter the Energy level
automatically to maintain a constant signal level.

(e) For Cary 400/500 set the Slit Height to ‘Full’.
(f) Click on the “UV/Vis” button if you want both lamps on

during the run.
(g) Check the ‘Auto Lamps Off’ checkbox if you want to

automatically turn off the lamps at the end of a collect.
This option enables you to preserve the lifetime of the
lamps. It is especially useful when performing Scan runs
overnight or unattended for long periods of time.

(h) Do not select the ‘Signal-to-Noise Mode’ checkbox.
(i) In the Display Options group, select the way in which

you want the data displayed as it is collected. Choose
the ‘Individual Data’ radio button to display the collected
data of each sample in individual graph boxes. Choose
the ‘Overlay Data’ radio button to superimpose the
collected data of each sample in the Scan run in one
graph box.

8. Setup dialog | Independent tab
If you are using a Cary 500 do not change any options on this
tab.
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Set up the baseline correction

9. Setup dialog | Baseline tab
(a) Select the Baseline tab.
(b) Select ‘Baseline Correction’. This will force the Cary to

perform a baseline correction on the sample data. The
correction will be performed on each point before it is
displayed.

✒ Note You can use a stored baseline at this stage. To do so, press the
“Baseline” button and open the saved CSW baseline file.

Make sure that no accessories are selected

10. Setup dialog | Accessories 1 tab
Make sure that no options are selected on this tab and no
accessories are installed.

11. Setup dialog | Accessories 2 tab
Make sure that no options are selected on this tab and no
accessories are installed.

12. Setup dialog | Accessories 3 tab
Make sure that no options are selected on this tab and no
accessories are installed.

Set up reporting and printing requirements

13. Setup dialog | Reports tab
(a) Select the Reports tab and specify your reporting

requirements for this method.
(b) Enter your name in the Name entry field.
(c) Enter a comment relating to your sample in the

Comment entry field.
(d) Set up your report style by selecting the appropriate

checkboxes in the Options group.
For example, select the ‘AutoPrint’ checkbox to obtain a
printout of your report automatically.
Select the ‘Parameters’ checkbox to include your
experimental parameters in the report.
Select the ‘Graph’ checkbox to include a graph in the
printed report.

✒ Note If ‘AutoPrint’ is selected, then the system will send the report
information to the specified printer as well as the Report area.
However, if ‘AutoPrint’ is not selected, the report will only be sent
to the Report area and can be viewed by selecting Report in the
View menu.
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(e) Set up the Peak Table reporting.
(i) Select Peak Labels.
(ii) Press the “Peak Information” button and choose
the type of Peak Labels, the Peak Style and set the
Peak Threshold. Press “OK”.
(iii) Select Maximum Peak to report the peak with
the largest peak threshold that exceeds the Peak
Threshold value.
(iv) Select All Peaks to report all peaks meeting the
Peak Style criterion and exceeding the Threshold
value.

(f) Set up ‘X-Y pairs’ reporting if required. You can use the
actual Data Interval by which the data was collected or
you can make the Cary interpolate the points to a new
Interval.

(g) Select the ‘Autoconvert’ option you require. If you select
‘Select for ASCII (csv)’ or ‘Select for ASCII (csv) with
Log’, then at the end of the data collection the system
will automatically generate a report and store the data
both in the Cary format as well as ASCII XY pairs format
in the current folder.

Set up storage of collected data

14. Setup dialog | Auto Store tab
(a) Select the Auto Store tab to set up whether the collected

data is to be saved, and if so, when the Cary should
store the information.

(b) Select ‘Storage On (Prompt at Start)’.

Set up visual system monitoring

15. Select the ‘Show Status Display’ checkbox to display various
information fields on your current reaction.

Finish setup

16. Once you are satisfied with your method setup click “OK” to
confirm any changes you have made and close the Setup
dialog.

Zero the instrument

17. Click the “Zero” button to zero the system. Alternatively,
select Zero in the Commands menu to perform a zero.

Measure a baseline

18. To measure a baseline:
(a) Click the “Baseline” button to set up the baseline

collection the system. Alternatively, select Baseline in
the Commands menu.
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(b) When prompted, insert the blank sample into the sample
compartment front beam and press “OK”. The Cary will
collect the baseline scan. After the collection, the word
‘baseline’ will appear in red in the ordinate status box,
indicating that you are in baseline correction mode and
you have a valid baseline file for the correction.

✒ Note If the word ’baseline’ is gray and italicized, the baseline file is still
valid. The gray and italics indicates that the Cary is idling outside
the abscissa range of the baseline file.

Start the Scan run

19. Click the application “Start” button to start a data collection.
Alternatively, select Start in the Commands menu.

Set up file name for the data and sample names

20. To set up a file name:
(a) Once you press “Start”, the Windows Save As dialog will

appear. Enter the appropriate file name for data and
press “Save”.

(b) The Sample Name dialog will now appear. Enter the
appropriate name for your sample and press “OK”. This
is the name that the trace will be displayed and printed
with.
The Scan run will commence and the corrected trace will
appear in the Graphics area. At the end of the run, the
Cary will create the report and also print it, if ‘AutoPrint’
has been selected in the Reports tab of the Setup dialog.

4.8.2 How to perform a scan in Signal-to-Noise
mode (Cary 100-500)

This demonstrates how to perform a wavelength scan from 500 nm
to 400 nm in signal-to-noise mode (Cary 100, 300, 400, 500).

Start the Scan application

1. On the Windows Taskbar, click “Start” to display the Start
menu.

2. Move the cursor over the Programs menu item to display the
Programs menu.

3. Select Scan in the Cary WinUV menu.
4. Select your instrument type (if necessary) and press “OK” to

open the Scan application.
(Alternatively, you can double click on the Scan icon in the
Cary WinUV folder on the desktop.)
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✒ Note If you are running a GLP system you may be prompted to enter a
password before accessing the Scan application.

Set up data collection parameters

5. Setup dialog
Click the “Setup…” button or select Setup from the Menu line
to display the Setup dialog box and specify the method
parameters for a new method.

To do this:

Set up instrument parameters such as X Mode, Y Mode,
wavelength range etc.

6. Setup dialog | Cary tab
(a) Set the appropriate abscissa mode for the scan in the X

Mode field, for example ‘nanometers’.
(b) Set the wavelength range for the scan by entering the

values you require in the Start/Stop fields, for example
‘500/400’.

(c) In the Y Mode field select the ordinate mode in which
you want the collect data to be displayed, for example
‘Abs’.

(d) Enter an upper range and lower range value in the Y min
and Y max entry fields to specify the displayed ordinate
range. If the data goes outside the display region you
can use the “Autoscale” button during the data collection
to automatically scale the display.

(e) You now need to set the speed of the data collection.
With the Cary instruments you do this by setting the Ave
Time and Data Interval. In the Ave Time field enter the
required value. 0.1 sec is a good starting value.

(f) In the Data Interval field, enter the wavelength increment
you require between data points. A good starting point is
0.5. The Cary will automatically update the Scan Rate
field when you select it.

(g) Make sure that Cycle Mode is not selected.
Set up SBW, lamp and graphics options

7. Setup dialog | Options tab
(a) Select the Options tab.
(b) If you are using a Cary 400, select ‘Fixed SBW’ for the

run.
(c) If you are using a Cary 100, 300 or 500, set the SBW for

the run. A good starting point is 2 nm if your method
does not specify a SBW.
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(d) Set the Beam Mode for the run. This is commonly set to
‘Double’.

(e) If you are using a Cary 500, do not set the Energy. The
Cary will use a fixed SBW for the run and will alter the
Energy level automatically to maintain a constant signal
level.

(f) If you are using a Cary 400/500, set the Slit Height to
‘Full’.

(g) Click on the “UV/Vis” button if you want both the lamps
on during the run.

(h) Check the ‘Auto Lamps Off’ checkbox if you want to
automatically turn off the lamps at the end of a collect.
This option enables you to preserve the lifetime of the
lamps. It is especially useful when performing Scan runs
overnight or unattended for long periods of time.

(i) Tick the ‘Signal-to-Noise Mode’ checkbox, and set the
required values for the Acceptable S/N and the S/N
Timeout, for example ‘1000 and 1 s’.

(j) In the Display Options group, select the way in which
you want the data displayed as it is collected. Choose
the ‘Individual Data’ radio button to display the collected
data of each sample in individual graph boxes. Choose
the ‘Overlay Data’ radio button to superimpose the
collected data of each sample in the Scan run in one
graph box.

8. Setup dialog | Independent tab
(a) Make sure that Independent Control is not checked.
(b) Set measurement Mode to Auto.

Set up the baseline correction

9. Setup dialog | Baseline tab
(a) Select the Baseline tab.
(b) Select ‘Baseline Correction’. This will force the Cary to

perform a baseline correction on the sample data. The
correction will be performed on each point before it is
displayed.

✒ Note A stored baseline can be used at this stage. To do so, press the
“Baseline” button and open the saved CSW baseline file.

Make sure that no accessories are selected

10. Setup dialog | Accessories 1 tab
Make sure that no options are selected on this tab and no
accessories are installed.
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11. Setup dialog | Accessories 2 tab
Make sure that no options are selected on this tab and no
accessories are installed.

12. Setup dialog | Accessories 3 tab
Make sure that no options are selected on this tab and no
accessories are installed.

Set up reporting and printing requirements

13. Setup dialog | Reports tab
(a) Select the Reports tab and specify your reporting

requirements for this method.
(b) Enter your name in the Name entry field.
(c) Enter a comment relating to your experiment in the

Comment entry field.
(d) Set up your report style by selecting the appropriate

checkboxes in the Options group.
For example, select the ‘AutoPrint’ checkbox to obtain a
printout of your report automatically.
Select the ‘Parameters’ checkbox to include your
experimental parameters in the report.
Select the ‘Graph’ checkbox to include a graph in the
generated report.

✒ Note If ‘AutoPrint’ is selected, then the system will send the report
information to the specified printer as well as the Report area.
However if ‘AutoPrint’ is not selected, the report will only be sent to
the Report area and can be viewed by selecting the Report option
in the View menu.

(e) Set up the Peak Table reporting.
(i) Select Peak Labels.
(ii) Press the “Peak Information” button and choose
the type of Peak Labels, the Peak Style and set the
Peak Threshold. Press “OK”.
(iii) Select Maximum Peak to report the peak with
the largest peak threshold that exceeds the Peak
Threshold value.
(iv) Select All Peaks to report all peaks meeting the
Peak Style criterion and exceeding the Threshold
value.

(f) Set up X-Y pairs reporting if required. You can use the
actual Data Interval by which the data was collected or
you can make the Cary interpolate the points to a new
Interval.
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(g) Select the ‘Autoconvert’ option you require. If you select
‘Select for ASCII (csv)’ or ‘Select for ASCII (csv) with
Log’, then at the end of the data collection the system
will automatically generate a report and store the data
both in the Cary format as well as ASCII XY pairs format
in the current folder.

Set up storage of collected data

14. Setup dialog | Auto Store tab
(a) Select the Auto Store tab to set up whether the collected

data is to be saved, and if so, when the Cary should
store the information.

(b) Select ‘Storage On (Prompt at End)’.

Set up visual system monitoring

15. Select the ‘Show Status Display’ checkbox to display various
information fields on your current reaction.

Finish setup

16. Once you are satisfied with your method setup click “OK” to
confirm any changes you have made and close the Setup
dialog.

Zero the instrument

17. Click the “Zero” button to zero the system. Alternatively,
select Zero in the Commands menu to perform a zero.

Measure a baseline

18. To measure a baseline:
(a) Click the “Baseline” button to set up the baseline

collection the system. Alternatively, select Baseline in
the Commands menu.

(b) When prompted, insert the blank sample into the sample
compartment front beam and press “OK”.  The Cary will
collect the baseline scan. After the collection, the word
‘baseline’ will appear in red in the ordinate status box,
indicating that you are in baseline correction mode and
you have a valid baseline file for the correction.

✒ Note If the word ’baseline’ is gray and italicized, the baseline file is still
valid. The gray and italics indicates that the Cary is idling outside
the abscissa range of the baseline file.

Start the Scan run

19. Click the application “Start” button to start a data collection.
Alternatively, you can select Start in the Commands menu.
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Set up sample names

20. Once you press “Start”, the Sample Name dialog will appear.
Enter the appropriate name for you sample and press “OK”.
The Scan run will commence and the corrected trace will
appear in the Graphics area.
If for a particular point, the set Acceptable S/N cannot be met
in the set S/N Timeout time, then the Cary will collect the
point as normal (using the S/N Timeout as the Ave Time) and
display the message SNR Timeout in the hardware status
area.

Save the collected data

21. When the Cary has measured the sample, the Save As dialog
box will appear. Enter the appropriate name for your sample
press “Save”. The Cary will then create the report and also
print it, if ‘AutoPrint’ has been selected in the Reports tab of
the Setup dialog.

4.8.3 How to perform a scan in Independent mode
(Cary 500)

This demonstrates how to perform a wavelength scan from 2200
nm to 400 nm in Independent mode (Cary 500 only).

Start the Scan application

1. On the Windows Taskbar, click “Start” to display the Start
menu.

2. Move the cursor over the Programs menu item to display the
Programs menu.

3. Select Scan in the Cary WinUV menu.
4. Select your instrument type (if necessary) and press “OK” to

open the Scan application.
(Alternatively, you can double click on the Scan icon in the
Cary WinUV folder on the desktop.)

✒ Note If you are running a GLP system you may be prompted to enter a
password before accessing the Scan application.

Set up data collection parameters

5. Click the “Setup” button or select Setup from the Menu line to
display the Setup dialog box and specify the method
parameters for a new method.
To do this:
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Set up instrument parameters such as X Mode, Y Mode,
wavelength range etc.

6. Setup dialog | Cary tab
(a) Set the appropriate abscissa mode for the scan in the X

Mode field, for example ‘nanometers’.
(b) Set the wavelength range for the scan by entering the

values you require in the Start/Stop fields, for example
‘2200/400’.

(c) In the Y Mode field select the ordinate mode in which
you want the collect data to be displayed, for example
‘Abs’.

(d) Enter an upper range and lower range value in the Y min
and Y max entry fields to specify the displayed ordinate
range. If the data goes outside the display range during
the collection you can use the “Autoscale” to
automatically scale the data.

(e) Do not set any Scan Controls, such as Ave Time or Data
Interval, as the settings in Independent mode will
override these.

(f) Make sure that ‘Cycle Mode’ is not selected.

Set up SBW, lamp and graphics options

7. Setup dialog | Options tab
(a) Select the Options tab.
(b) Do not set the SBW or Energy as the settings in

Independent mode will override these.
(c) Set the Beam Mode for the run. This is commonly set to

‘Double’.
(d) Set the Slit Height to ‘Full’.
(e) Click on the “UV/Vis” button if you want both the lamps

on during the run.
(f) Check the ‘Auto Lamps Off’ checkbox if you want to

automatically turn off the lamps at the end of a collect.
This option enables you to preserve the lifetime of the
lamps. It is especially useful when performing Scan runs
overnight or unattended for long periods of time.
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(g) In the Display Options group, select the way in which
you want the data displayed as it is collected. Choose
the ‘Individual Data’ radio button to display the collected
data of each sample in individual graph boxes. Choose
the ‘Overlay Data’ radio button to superimpose the
collected data of each sample in the Scan run in one
graph box.

Set up the signal level controls (SBW/Energy) for the scan

8. Setup dialog | Independent tab
(a) Select the Independent tab.
(b) Tick the ‘Independent Control’ checkbox.
(c) Select the Measurement Mode as ‘Auto’. This will mean

that the Cary will use a Fixed SBW in the UV-Vis region
and a fixed Energy level in the NIR region.

(d) In the UV-Vis group, set the parameters you require in
the UV-Vis region. Good starting values are: Ave Time =
0.1, Data Interval = 1, Scan Rate = 600, SBW = 2.

(e) In the NIR group, set the parameters you require in the
NIR region. Good starting values are: Ave Time = 0.1,
Data Interval = 4, Scan Rate = 2400, Energy=1.

Set up baseline correction

9. Setup dialog | Baseline tab
(a) Select the Baseline tab.
(b) Select ‘Baseline Correction’. This will force the Cary to

perform a baseline correction on the sample data. The
correction will be performed on each point before it is
displayed.

✒ Note You can use a stored baseline at this stage. To do so, press the
“Baseline” button and open the saved CSW baseline file.

Make sure that no accessories are selected

10. Setup dialog | Accessories 1 tab
Make sure that no options are selected on this tab and no
accessories are installed.

11. Setup dialog | Accessories 2 tab
Make sure that no options are selected on this tab and no
accessories are installed.

12. Setup dialog | Accessories 3 tab
Make sure that no options are selected on this tab and no
accessories are installed.
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Set up reporting and printing requirements

13. Setup dialog | Reports tab
(a) Select the Reports tab and specify your reporting

requirements for this method.
(b) Enter your name in the Name entry field.
(c) Enter a comment relating to your experiment in the

Comment entry field.
(d) Set up your report style by selecting the appropriate

checkboxes in the Options group.
For example, select the ‘AutoPrint’ checkbox to obtain a
printout of your report automatically. Select the
‘Parameters’ checkbox to include your experimental
parameters in the report. Select the ‘Graph’ checkbox to
include a graph in the generated report.

✒ Note If ‘AutoPrint’ is selected, then the system will send the report
information to the specified printer as well as the Report area.
However, if ‘AutoPrint’ is not selected, the report will only be sent
to the Report area and can be viewed by selecting the Report
option in the View menu.

(e) Set up the Peak Table reporting.
(i) Select Peak Labels.
(ii) Press the “Peak Information” button and choose
the type of Peak Labels, the Peak Style and set the
Peak Threshold. Press “OK”.
(iii) Select Maximum Peak to report the peak with
the largest peak threshold that exceeds the Peak
Threshold value.
(iv) Select All Peaks to report all peaks meeting the
Peak Style criterion and exceeding the Threshold
value.

(f) Set up X-Y pairs reporting if required. You can use the
actual Data Interval by which the data was collected or
you can make the Cary interpolate the points to a new
Interval.

(g) Select the ‘Autoconvert’ option you require. If you select
‘Select for ASCII (csv)’ or ‘Select for ASCII (csv) with
Log’, then at the end of the data collection the system
will automatically generate a report and store the data
both in the Cary format as well as ASCII XY pairs format
in the current folder.



Cary WinUV

4-74

Set up storage of collected data

14. Setup dialog | Auto Store tab
(a) Select the Auto Store tab to set up whether the collected

data is to be saved, and if so, when the Cary should
store the information.

(b) Select ‘Storage On (Prompt at End)’.

Set up visual system monitoring

15. Select the ‘Show Status Display’ checkbox to display various
information fields on your current reaction.

Finish setup

16. Once you are satisfied with your method setup, click “OK” to
confirm any changes you have made and close the Setup
dialog.

Zero the instrument

17. Click the “Zero” button to zero the system. Alternatively,
select Zero in the Commands menu to perform a zero.

Measure a baseline

18. To measure a baseline:
(a) Click the “Baseline” button to set up the baseline

collection. Alternatively, select Baseline in the
Commands menu.

(b) When prompted, insert the blank sample into the sample
compartment front beam and press “OK”.
The Cary will collect the baseline scan. After the
collection, the word ‘baseline’ will appear in red in the
ordinate status box, indicating that you are in baseline
correction mode and you have a valid baseline file for
the correction.

✒ Note If the word ’baseline’ is gray and italicized, the baseline file is still
valid. The gray and italics indicates that the Cary is idling outside
the abscissa range of the baseline file.

Start the Scan run

19. Click the application “Start” button to start a data collection.
Alternatively, you can select Start in the Commands menu.

Set up sample names

20. Once you press “Start”, the Sample Name dialog will appear.
Enter the appropriate name for you sample and press “OK”.
The Scan run will commence and the corrected trace will
appear in the Graphics area.
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Save the collected data

21. When the Cary has measured the sample, the Save As dialog
box will appear. Enter the appropriate name for your sample
press “Save”. The Cary will then create the report and also
print it, if ‘AutoPrint’ has been selected in the Reports tab of
the Setup dialog.

4.8.4 How to perform a scan with baseline
correction (Cary 50)
This demonstrates how to perform a wavelength scan
from 500 nm to 400 nm with baseline correction (Cary
50).

Start the Scan application

1. On the Windows Taskbar, click “Start” to display the Start
menu.

2. Move the cursor over the Programs menu item to display the
Programs menu.

3. Select Scan in the Cary WinUV menu.
4. Select your instrument type (if necessary) and press “OK” to

open the Scan application.
(Alternatively, you can double click on the Scan icon in the
Cary WinUV folder on the desktop.)

✒ Note If you are running a GLP system you may be prompted to enter a
password before accessing the Scan application.

Set up data collection parameters

5. Setup dialog
Click the “Setup…” button or select Setup from the Menu line
to display the Setup dialog box and specify the method
parameters for a new method.

To do this:

Set up instrument parameters such as wavelength range, Y
Mode, scan speed etc.

6. Setup dialog | Cary tab
(a) Set the wavelength range for the scan by entering the

values you require in the Start/Stop fields, for example
‘500/400’.
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(b) In the Y Mode field select the ordinate mode in which
you want the collect data to be displayed, for example
‘Abs’.

(c) Enter an upper range and lower range value in the Y min
and Y max entry fields to specify the displayed ordinate
range.

(d) Make sure that ‘Cycle Mode’ is not selected.
(e) Set the Beam Mode for the run. This is should be set to

‘Dual Beam’.
(f) In the Scan Controls group, select ‘Simple’ and click a

scan speed button. Alternatively, you can select
‘Advanced’ and enter an Ave Time and Data Interval (the
Cary will then select the Scan Speed).

(g) In the Display Options group, select the way in which
you want the data displayed as it is collected. Choose
the ‘Individual Data’ radio button to display the collected
data of each sample in individual graph boxes. Choose
the ‘Overlay Data’ radio button to superimpose the
collected data of each sample in the Scan run in one
graph box.

Set up the baseline correction

7. Setup dialog | Baseline tab
(a) Select the Baseline tab.
(b) Select ‘Baseline Correction’. This will force the Cary to

perform a baseline correction on the sample data. The
correction will be performed on each point before it is
displayed.

✒ Note You can use a stored baseline at this stage. To do so, press the
“Baseline” button and open the saved CSW baseline file.

Make sure that no accessories are selected

8. Setup dialog | Accessories 1 tab
Make sure that no options are selected on this tab and no
accessories are installed.

9. Setup dialog | Accessories 2 tab
Make sure that no options are selected on this tab and no
accessories are installed.

Set up reporting and printing requirements

10. Setup dialog | Reports tab
(a) Select the Reports tab and specify your reporting

requirements for this method.
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(b) Enter your name in the Name entry field.
(c) Enter a comment relating to your experiment in the

Comment entry field.
(d) Set up your report style by selecting the appropriate

checkboxes in the Options group.
For example, select the ‘AutoPrint’ checkbox to obtain a
printout of your report automatically. Select the
‘Parameters’ checkbox to include your method
parameters in the report. Select the ‘Graph’ checkbox to
include a graph in the generated report.

✒ Note If ‘AutoPrint’ is selected, then the system will send the report
information to the specified printer as well as the Report area.
However if ‘AutoPrint’ is not selected, the report will only be sent to
the Report area and can be viewed by selecting Report in the View
menu.

(e) Set up the Peak Table reporting.
(i) Select Peak Labels.
(ii) Press the “Peak Information” button and choose
the type of Peak Labels, the Peak Style and set the
Peak Threshold. Press “OK”.
(iii) Select Maximum Peak to report the peak with
the largest peak threshold that exceeds the Peak
Threshold value.
(iv) Select All Peaks to report all peaks meeting the
Peak Style criterion and exceeding the Threshold
value.

(f) Set up X-Y pairs reporting if required. You can use the
actual Data Interval by which the data was collected or
you can make the Cary interpolate the points to a new
Interval.

(g) Select the Autoconvert option you require. If you select
‘Select for ASCII (csv)’ or ‘Select for ASCII (csv) with
Log’, then at the end of the data collection the system
will automatically generate a report and store the data
both in the Cary format as well as ASCII XY pairs format
in the current folder.

Set up storage of collected data

11. Setup dialog | Auto Store tab
(a) Select the Auto Store tab to set up whether the collected

data is to be saved, and if so, when the Cary should
store the information.

(b) Select ‘Storage On (Prompt at Start)’.
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Set up visual system monitoring

12. Select the ‘Show Status Display’ checkbox to display various
information fields on your current reaction.

Finish setup

13. Once you are satisfied with your method setup click “OK” to
confirm any changes you have made and close the Setup
dialog.

Zero the instrument

14. Click the “Zero” button to zero the system.

Measure a baseline

15. To measure a baseline:
(a) Click the “Baseline” button to set up the baseline

collection the system. Alternatively, select Baseline in
the Commands menu.

(b) When prompted, insert the blank sample into the sample
compartment front beam and press “OK”.
The Cary will collect the baseline scan. After the
collection, the word ‘baseline’ will appear in red in the
ordinate status box, indicating that you are in baseline
correction mode and you have a valid baseline file for
the correction.

✒ Note If the word ’baseline’ is gray and italicized, the baseline file is still
valid. The gray and italics indicates that the Cary is idling outside
the abscissa range of the baseline file.

Start the Scan run

16. Click the application “Start” button to start a data collection.
Alternatively, you can select Start in the Commands menu.

Set up file name for the data and sample names

17. To set up a file name:
(a) Once you press “Start”, the Windows Save As dialog will

appear. Enter the appropriate name for your Scan run
and press “Save”.

(b) The Sample Name dialog will now appear. Enter the
appropriate name for your sample and press “OK”. The
Scan run will commence and the corrected trace will
appear in the Graphics area. At the end of the run, the
Cary will create the report and also print it if ‘AutoPrint’
has been selected in the Reports tab of the Setup dialog.
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4.9 Scanning Kinetics
The following Scanning Kinetics How to… procedures are
described.

❑ How to collect data using the Multicell Holder with
temperature control (Cary 100–500)

❑ How to collect data (Cary 50)

4.9.1 How to collect data using the Multicell
Holder with temperature control (Cary 100–
500)

This demonstrates how to perform a multicell, multi-stage
wavelength scan with baseline correction from 600 to 500
nanometers at 37 °C using the Temperature Controller accessory
with the Multicell Holder accessory (Cary 100, 300, 400 and 500).

You can then use the data to create kinetics continuums in order to
calculate reaction rates.

Start the Scanning Kinetics application

1. On the Windows Taskbar, click ‘”Start” to display the Start
menu.

2. Move the cursor over the Programs menu item to display the
Programs menu.

3. Select Scanning Kinetics in the Cary WinUV menu.
4. Select your instrument type (if necessary) and press “OK” to

open the Scanning Kinetics application.
(Alternatively, you can double click on the Scanning Kinetics
icon in the Cary WinUV folder on the desktop.)

✒ Note If you are running a GLP system, you may be prompted to enter a
password before accessing the Scanning Kinetics application.

Set up data collection parameters

5. Setup dialog
Click the “Setup…” button or select Setup from the Menu line
to display the Setup dialog box and specify the method
parameters for a new method.

To do this:
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Select baseline correction type

6. Setup dialog | Baseline tab
(a) Select the Baseline tab.
(b) Select the Baseline correction radio button. This will

force the Cary to use a baseline scan to perform a
baseline correction on the sample data. The correction
will be performed on each point before it is displayed.

✒ Note You can use a stored baseline at this stage. To do so, press the
“Retrieve Baseline file” button and open the saved *.CSK baseline
file.

Set up Multicell Holder accessory with multi zero

7. Setup dialog | Accessories tab
(a) Select the Accessories tab.
(b) Ensure that you have the appropriate accessories

installed prior to commencing the run.
(c) Select the Use Cell Changer checkbox to enable the

Multicell Holder accessory.
(d) If the option is available, choose the type of Multicell

Holder you are using (6 x 6 or 8 x 6).
(e) Choose the Select Cells radio button and select the cells

you require from the available cells in the Use Cells
group.
For Front Beam analysis, select the checkboxes Cell 1–
Cell 6
(6 x 6) or Cell 1–Cell 8 (8 x 6). This will ensure that all
front cell positions in the Multicell Holder will be
measured during your scanning kinetics analysis.

(f) Check the Multi Zero checkbox to turn on the Multi Zero
facility.

Set up accessories for reaction temperature control and
temperature display

8. Setup dialog | Accessories tab
(a) If you are not using a Peltier controlled accessory (e.g.

the water thermostatted 8 x 6) ensure that you have the
Temperature Controller accessory installed prior to
commencing the run.

(b) Tick Automatic Temperature Setting and select the
Temperature Controller to enable the accessory.

(c) Set the monitoring temperature by entering the Block
temperature as 37 °C. (The monitoring device is
selected in Step 10 part (j).)
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(d) In the Temperature Display group, select Block and
Probe 1 to view the temperature of the Multicell Holder
block and one temperature Probe in the Status Display
window.

Set up instrument parameters such as X mode, Y mode,
wavelength range etc.

9. Setup dialog | Cary tab
Select the Cary tab and specify the Instrument parameters for
your analysis.

(a) Set the appropriate abscissa mode for the scan in the X
Mode field, for example nanometers.

(b) Set the wavelength range for the scan by entering the
values you require in the Start/Stop fields, for example
500/400.

(c) In the Y Mode field, select the ordinate mode you
require. Click Abs to specify the Absorbance mode or
%T to specify percent Transmittance.

(d) Enter an upper range and lower range value in the Y min
and Y max entry fields to specify the displayed ordinate
range.

(e) You now need to set the speed of the data collection.
With the Cary instruments you do this by setting the Ave
Time and Data Interval. In the Ave Time field enter the
required value. 0.1 sec is a good starting value.

(f) In the Data Interval field, enter the wavelength increment
you require between data points. 0.5 nm is a good
starting point. The Cary will automatically update the
Scan Rate field when you select it.

Set up rate parameters such as the number of different rates
in the reaction, the speed and duration of the data collection

10. Setup dialog | Cary tab
Select the Advanced Collect radio button in the Collect Timing
group. This enables you to set up different data collection
procedures for the multiple rates in your reaction.

✒ Note The Advanced Collect facility enables you to collect data more
frequently during the crucial stages of your scanning kinetics
reaction and to collect data less frequently where you know there
will not be much activity.

(g) Enter the number of different reaction rates that you
require in the Number of Stages entry field. The number
you set here will be reflected in the table below.
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(h) Specify how long the Cary will wait after reading each
cell before it starts another reading cycle by setting the
Cycle time for each rate Stage.

(i) Specify the duration of the Scanning Kinetics run by
setting the Stop time for each rate Stage.

(j) Choose the desired temperature monitoring device in the
Monitor field. The “Start” button will not be enabled until
the temperature of the selected Monitor is within 0.5 °C
of the Block temperature set in the Accessories tab
(Step 8 part (c)).

Set up spectral bandwidth or energy and lamp options

11. Setup dialog | Options tab
(a) Select the Options tab.
(b) Set the SBW for the run.
(c) Set the Slit Height to Full.
(d) Check the Auto Lamps Off checkbox if you want to

automatically turn off the lamps at the end of a collect.
This option enables you to preserve the lifetime of the
lamps. It is especially useful for when performing data
collections overnight or unattended for long periods of
time.

(e) Click on the “UV/Vis” button if you want both the lamps
on during the run.

(f) Enter your required Source Changeover and Detector
Changeover (Cary 500 only) wavelengths in the
corresponding entry fields.

Set up analysis parameters

12. Setup dialog | Analyze tab
This tab is used for post-run analysis.

Set up reporting and printing requirements

13. Setup dialog | Reports tab
(a) Select the Reports tab.
(b) Enter your name in the Name entry field.
(c) Enter a comment relating to your experiment in the

Comment entry field.
(d) Set up your report style by selecting the appropriate

checkboxes in the Options group.
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For example, select the Auto Print checkbox to obtain a
printout of your report automatically.
Select the Parameters checkbox to include your
experimental parameters in the report.
Select the Graph checkbox to include a graph in the
generated report.

✒ Note If Auto Print is selected, then the system will send the report
information to the specified printer as well as to the Report area.
However if Auto Print is not selected, the report will only be sent to
the Report area and can be viewed by selecting the Report option
in the View menu.

(e) Check Include X-Y Pairs Table to view a list of abscissa
values and their corresponding ordinate values.

(f) Select the Autoconvert option you require.
(g) If you choose Select for ASCII (csv) or Select for ASCII

(csv) with Log, then at the end of the data collection the
system will automatically generate a report and store the
data both in the Cary format as well as ASCII XY pairs
format in the current folder.

Set up storage of collected data

14.  Setup dialog | Auto Store tab
(a) Select the Auto Store tab to set up whether the collected

data is to be saved, and if so, when the Cary should
store the information.

(b) Select Storage On (Prompt at Start), to set up the Cary
to prompt you for a file name before the start of a
Scanning Kinetics run.

Set up visual system monitoring

15. Select the Show Status Display checkbox on any of the tabs
to display various information fields on your current reaction.

Finish setup

16. Click “OK” to save any changes you have made and close the
Setup dialog. Depending on the cells selected in the Multicell
Holder, the Cary may then inform you that it will perform a
dual single beam calibration . Press “OK”.

Measure a baseline

17. To measure a baseline:
(a) If you do not have a valid baseline file, the Cary will

prompt you to click the “Baseline” button. Click the
“Baseline” button to set up the baseline collection.
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(b) The system will display a Cell Loading Guide dialog box.
If you want, change the name of the blank.

(c) Insert blank samples into the cell changer to collect the
0Abs/100%T baseline scans and click “OK”.
The system will set up the Graphics area and the Cary
will collect the baseline scan. After the collection, the
word ‘baseline’ will appear in red in the ordinate status
box, indicating that you are in baseline correction mode
and you have a valid baseline file for the correction.

If you want to use the baseline again with other samples,
save the method using File | Save Method As. Then,
when you re-open the method, the baseline will also
open and be ready to use. It is preferable to save the
baseline with the method, rather than a baseline file, as
that way you can be sure that all your collection
parameters are exactly the same for the new Scanning
Kinetics runs. However, Good Laboratory Practice
recommends that you collect a new baseline for each
laboratory session.

Zero the instrument

18. To zero the instrument:
(a) Click the “Zero” button to zero the system. Alternatively,

select Zero in the Commands menu to perform a zero.
(b) If you want, change the name of the blank/s.
(c) Insert blank samples into the appropriate positions of the

Multicell Holder and click “OK”.

Start the Scanning Kinetics run

19. To start the run:
(a) Click the “Start” button to start a data collection.

Alternatively you can select Start in the Commands
menu. Do not add your active reagent at this time.

✒ Note At this point, the system will display the Save File dialog box if you
have selected Storage On (Prompt at Start) on the Auto Store tab
of the Setup dialog. If so, enter the file name for this Scanning
Kinetics run in the File name field and press “Save”.

(b) The system will display a Cell Loading Guide dialog box.
If you want, change the names of the samples.

(c) Place the sample solution(s) in the correct cell positions
and click “OK”. The Sync Start dialog box will appear.
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(d) Add your active reagent just before the Count Down
reaches 0:00 or commence the data collection by
pressing the “OK” button.
At the end of the run, determine the actual Stop Time by
observing the last value in the Time column of the User
Data Form.

4.9.2 How to collect data (Cary 50)
This demonstrates how to perform a multicell, multi-stage
wavelength scan with baseline correction from 600 to 500
nanometers at ambient temperature (Cary 50).

You can then use the data to create kinetics continuums in order to
calculate reaction rates.

Start the Scanning Kinetics application

1. On the Windows Taskbar, click “Start” to display the Start
menu.

2. Move the cursor over the Programs menu item to display the
Programs menu.

3. Select Scanning Kinetics in the Cary WinUV menu.
4. Select your instrument type (if necessary) and press “OK” to

open the Scanning Kinetics application.
(Alternatively, you can double click on the Scanning Kinetics
icon in the Cary WinUV folder on the desktop.)

✒ Note If you are running a GLP system, you may be prompted to enter a
password before accessing the Scanning Kinetics application.

Set up data collection parameters

5. Setup dialog
Click the “Setup…” button or select Setup from the Menu line
to display the Setup dialog box and specify the method
parameters for a new method.

To do this:

Set up instrument parameters such as wavelength range, Y
Min/Max etc.

6. Setup dialog | Cary tab
Select the Cary tab and specify the Instrument parameters for
your analysis.
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(a) Set the wavelength range for the scan by entering the
values you require in the Start/Stop fields, for example
500/400.

(b) Enter an upper range and lower range value in the Y min
and Y max entry fields to specify the displayed ordinate
range.

(c) You now need to set the speed of the data collection.
With the Cary instruments you do this by setting the Ave
Time and Data Interval. In the Ave Time field enter the
required value. 0.1 sec is a good starting value.

(d) In the Data Interval field, enter the wavelength increment
you require between data points. 0.5 nm is a good
starting point. The Cary will automatically update the
Scan Rate field when you select it.

Set up rate parameters such as the number of different rates
in the reaction, the speed and duration of the data collection

7. Setup dialog | Cary tab
(a) Select the Advanced Collect radio button in the Collect

Timing group. This enables you to set up different data
collection procedures for the multiple rates in your
reaction.

✒ Note The Advanced Collect facility enables you to collect data more
frequently during the crucial stages of your scanning kinetics
reaction and to collect data less frequently where you know there
will not be much activity.

(b) Enter the number of different reaction rates that you
require in the Number of Stages entry field. The number
you set here will be reflected in the table below.

(c) Specify how long the Cary will wait after reading each
cell before it starts another reading cycle by setting the
Cycle time for each rate Stage.

(d) Specify the duration of the Scanning Kinetics run by
setting the Stop time for each rate Stage.

Select baseline correction type

8. Setup dialog | Baseline tab
(a) Select the Baseline tab.
(b) Select the Baseline correction radio button. This will

force the Cary to use a baseline scan to perform a
baseline correction on the sample data. The correction
will be performed on each point before it is displayed.
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✒ Note You can use a stored baseline at this stage. To do so, press the
“Retrieve Baseline file” button and open the saved *.CSK baseline
file.

Set up Multicell Holder accessory with multi zero

9. Setup dialog | Accessories tab
(a) Select the Accessories tab.
(b) Ensure that you have the appropriate accessories

installed prior to commencing the run.
(c) Select the Use Cell Changer checkbox to enable the

Multicell Holder accessory.
(d) Choose the Select Cells radio button and select the cells

you require from the available cells in the Use Cells
group.

(e) Check the Multi Zero checkbox to turn on the Multi Zero
facility.

Set up analysis parameters

10. Setup dialog | Analyze tab
This tab is used for post-run analysis.

Set up reporting and printing requirements

11. Setup dialog | Reports tab
(a) Select the Reports tab.
(b) Enter your name in the Name entry field.
(c) Enter a comment relating to your experiment in the

Comment entry field.
(d) Set up your report style by selecting the appropriate

checkboxes in the Options group.
For example, select the Auto Print checkbox to obtain a
printout of your report automatically. Select the
Parameters checkbox to include your experimental
parameters in the report. Select the Graph checkbox to
include a graph in the generated report.

✒ Note If Auto Print is selected, then the system will send the report
information to the specified printer as well as to the Report area.
However if Auto Print is not selected, the report will only be sent to
the Report area and can be viewed by selecting the Report option
in the View menu.

(e) Check Include X-Y Pairs Table to view a list of abscissa
values and their corresponding ordinate values.
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(f) Select the Autoconvert option you require.
If you select ASCII or ASCII with Log, then at the end of
the data collection the system will automatically generate
a report and store the data both in the Cary format as
well as ASCII XY pairs format in the current folder.

Set up storage of collected data

12. Setup dialog | Auto Store tab
(a) Select the Auto Store tab to set up whether the collected

data is to be saved, and if so, when the Cary should
store the information.

(b) Select Storage On (Prompt at Start), to set up the Cary
to prompt you for a file name before the start of a
Scanning Kinetics run.

Set up visual system monitoring

13. Select the Show Status Display checkbox on any of the tabs
to display various information fields on your current reaction.

Finish setup

14. Click “OK” to save any changes you have made and close the
Setup dialog.

Measure a baseline

15. If you do not have a valid baseline file, the Cary will prompt
you to click the “Baseline” button.
(a) Click the “Baseline” button to set up the baseline

collection.
(b) If you want, change the name of the blank.
(c) Insert blank samples into the cell changer to collect the

0Abs/100%T baseline scans and click “OK”.
The system will set up the Graphics area and the Cary
will collect the baseline scan. After the collection, the
word ‘baseline’ will appear in red in the ordinate status
box, indicating that you are in baseline correction mode
and you have a valid baseline file for the correction.

Zero the instrument

16. To zero the instrument:
(a) Click the “Zero” button to zero the system. Alternatively,

select Zero in the Commands menu to perform a zero.
(b) If you want, change the name of the blank/s.
(c) Insert blank samples into the appropriate positions of the

Multicell Holder and click “OK”.
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Start the Scanning Kinetics run

17. To start the run:
(a) Click the “Start” button to start a data collection.

Alternatively you can select Start in the Commands
menu. Do not add your active reagent at this time.

✒ Note At this point, the system will display the Save File dialog box if you
have selected Storage On (Prompt at Start) on the Auto Store tab
of the Setup dialog. If so, enter the file name for this Scanning
Kinetics run in the File name field and press “Save”.

(b) The system will display a Cell Loading Guide dialog box.
If you want, change the names of the samples.

(c) Place the sample solution(s) in the correct cell positions
and click “OK”. The Sync Start dialog box will appear.

(d) Add your active reagent just before the Count Down
reaches 0:00 or commence the data collection by
pressing the “OK” button.
At the end of the run, you can determine the actual Stop
Time by observing the last value in the Time column of
the User Data Form.

4.10 Simple Reads
The following Simple Reads How to… procedure is described:

❑ How to perform a measurement at a single wavelength

4.10.1 How to perform a measurement at a single
wavelength

Start the application

1. On the Windows Taskbar click “Start” to display the Start
menu.

2. Move the cursor over the Programs menu item to display the
Programs menu.

3. Select Simple Reads in the Cary WinUV menu to open the
Simple Reads application.
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4. Select your instrument type (if necessary) and press “OK” to
open the Simple Reads application.
(Alternatively, you can double click on the Simple Reads icon
in the Cary WinUV folder on the desktop.)

✒ Note If you are running a GLP system you may be prompted to enter a
password before accessing the Simple Reads application.

Set up instrument parameters (wavelength, Y mode)

5. Click the “Setup…” button or select Setup from the Menu line
to display the Setup dialog box. This displays the Cary tab
where you can specify the parameters for a new read.

6. Select ‘Read at Wavelength’ and enter the required
wavelength at which you want to perform the read.

7. In the Y Mode group select the button corresponding to the
ordinate mode you require. The ordinate mode determines
the way in which the photometric value is measured and
displayed in your report.

8. Click the “OK” button. The instrument will change to the new
wavelength.

Zero the instrument

9. Make sure that the sample compartment is clear (or you have
a blank in position) and zero the instrument by pressing the
“Zero” button. (Wait for the ordinate reading to reach ‘0’.)

Read the sample

10. Insert the sample into the sample compartment.
11. Wait while the instrument changes to the specified

wavelength. The current wavelength is displayed in the
Abscissa status display at the top and right of the application
window.

12. Click the “Read” button to perform photometric measurements
on the sample at the specified wavelength.
The result of the sample read appears in the Report area and
includes the ordinate reading obtained and the wavelength at
which the reading was measured.

Print the results

13. You can print the contents of the Report area by pressing the
“Print” button.
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4.11 Sunglasses
The following Sunglasses How to… procedure is described:

✒ Note This example assumes that you are using either the Simple or
Advanced interface for the Sunglasses application. If you are using
the Wizard (black screen with photo of the Sun) you will need to
change to another interface to use this example. To change the
interface refer to the online Help by clicking on the Windows Start
button, select Programs, Cary WinUV, Cary Help, Software help,
Sunglasses, Click on the General information folder and select the
How to change the Sunglass application interface link.

❑ How to perform a scan

4.11.1 How to perform a scan
1. Under the Options menu, select the desired sg_options.htm

International Standard(s) from the Options menu.
2. Click on the Sample Info.” button.
3. Enter all relevant information in the Sample Info. dialog and

click “OK”.
4. Select the Setup menu to display the Setup dialog.

Select Report Graph' if you want the trace(s) to be displayed.
Select 'Report XY Table' for XY pairs data.
Select 'Storage on (prompt at start)' to store the data.

Collect a Baseline

5. Click the Baseline” button to collect the baseline. You will be
prompted to insert a blank sample into the sample
compartment and click “OK” to collect the Baseline.
Once collected, the word 'Baseline' will appear in the Status
line on the main application window.

✒ Note The “Baseline” button reverts to a “Stop” button while the Baseline
is being collected. You can stop the collection by clicking this
button.

Position the sunglasses

6. The sunglasses need to be placed in the correct position in
the Cary to obtain accurate results. To do this:
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(a) Hold the sunglasses so that the lens is centered on the
cushion located on the sample compartment wall.

(b) With the sunglasses held in one hand, slide the barrel
towards the sunglasses until the barrel cushion is
pressed firmly against the lens. Apply sufficient pressure
so that when you let go of the sunglasses they are
supported between the compartment wall cushion and
the barrel cushion. Tighten the barrel screw to hold the
sunglasses in position. If they slip out of position, or fall
to the bottom of the sample compartment, move the
barrel away from the glasses and try again.

Performing a scan

7. When the sunglasses are securely in place, click the Scan”
button to perform the test.

Collect results

8. Once the test is complete the results will be displayed as set
in the Setup dialog in Step 4.

Print

9. Click the “Print” button if you would like to print out the results.

4.12 Thermal
The following Thermal How to… procedures are described.

❑ How to perform a run and determine Tm using Derivative
calculations

❑ How to perform a run and determine Tm using
Hyperchromicity calculations

4.12.1 How to perform a run and determine Tm
using Derivative calculations

This demonstrates how to perform a Thermal run using a single
temperature rate and automatically calculate Tm from the first
derivative.

Start the Thermal application

1. On the Windows Taskbar click “Start” to display the Start
menu.
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2. Move the cursor over the Programs menu item to display the
Programs menu.

3. Select Thermal in the Cary WinUV menu.
4. Select your instrument type (if necessary) and press “OK” to

open the Thermal application.
(Alternatively, you can double click on the Thermal icon in the
Cary WinUV folder on the desktop.)

✒ Note If you are running a GLP system, you may be prompted to enter a
password before accessing the Thermal application.

Set up data collection parameters

5. Setup dialog
Select the “Setup…” button or select Setup from the menu to
display the Setup dialog and specify the method parameters
for a new method.

To do this:

Set up instrument parameters such as wavelength, spectral
bandwidth, etc.

6. Setup dialog | Cary tab
(a) Select the Cary tab and specify the instrument

parameters for your analysis.
(b) In the Wavelength field enter the wavelength that you

want monitored.
(c) In the SBW field enter the required spectral bandwidth.
(d) In the Ave Time field enter the required value.

✒ Note For slow changes in temperature (i.e. slow ramp rates) it is
recommended that a long Ave Time (e.g. 2–3 seconds) be set.

(e) Enter the minimum and maximum graph ordinate values
in the Y Min and Y Max fields respectively.

Set up rate parameters such as the number of different rates
in the reaction, the speed and the duration of the data
collection

7. Setup dialog | Cary tab
(a) In the Cary tab specify the Collect Temperatures

parameters:
(b) In the Start °C entry field, enter the temperature at which

you want to commence the data collection.

✒ Note Once you press “OK” to dismiss the Setup dialog, the Cary will
drive the temperature to the specified Start Temperature.
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(c) In the Return °C entry field, enter the temperature that
you want the Temperature Controller to drive to at the
end of the data collection.

(d) Select the Monitor that the Cary will use to record the
temperature for each data point during the run.

(e) Select Simple Collect to set a single rate of temperature
change for the entire Thermal run.

(f) Enter the Data Interval, ramp Rate, and End temperature
and Hold time you require in the corresponding cell in
the single row table. Select the stages where you want
to collect data in the Collect Data column.

Set up the lamp source operation and data display options

8. Setup dialog | Options tab
(a) Select the Options tab and specify the source conditions

and data display options for your analysis.
(b) Tick the ‘Auto Lamps Off’ checkbox if you want to

automatically turn off the lamps at the end of a collect.
This option enables a user to preserve the lifetime of the
lamps. It is especially useful for when performing
Thermal data collections overnight or unattended for
long periods of time.

(c) Click on the ‘UV/Vis’ radio button if you want both the
lamps on during the run.

(d) In the Display Options group, select the way in which
you want the data displayed as it is collected. Choose
the ‘Individual Data’ radio button to display the collected
data of each sample in individual graph boxes. Choose
the ‘Overlay Data’ radio button to superimpose the
collected data of each sample in the Thermal run in one
graph box.

Set up accessories

9. Setup dialog | Accessories tab
Select the Accessories tab and make sure that no
accessories are selected.

Set up the analysis to reduce measurement interference

10. Setup dialog | Analyze tab
(a) Select the Analyze tab.
(b) Select smoothing and nominate the smoothing interval

and filter size to control the number of measurement
points to be averaged.



Cary WinUV

4-95

Set up a derivative method of analysis

11. Setup dialog | Analyze tab
(a) Check the ‘Derivative’ option to choose the derivative

method to calculate the temperature at which 50% of the
DNA strands have separated (Tm).

(b) Select the ‘Autocalculate’ checkbox to automatically
perform a derivative calculation on collected data at the
end of each run.

✒ Note You can perform the derivative calculation manually, once the run
is completed.

Now set the parameters to define the range over which
to calculate and plot the first derivative of the selected
scan. To do this:

(c) Enter the Interval at which data is sampled in order to
perform a derivative calculation. A derivative calculation
involves the collection of points from a plot. Selection of
these points is dependent upon the data interval chosen.
The data points are then used to generate a separate
trace from which a derivative calculation is performed.
The selection of the Derivative Interval is dependent on
the rate of data collection. If data is collected every 0.1
°C then a derivative interval of 0.1 °C will give the most
accurate result.

(d) Enter the Filter Size you require for the derivative
calculation. The derivative uses a Savitzky Golay
technique where a number of points surrounding an
individual point are averaged to produce a new,
smoothed point. For example, a five point derivation
uses the two data points before and after each data
point.

✒ Note The larger the filter size, the more data points that are included in
the filter for smoothing.

(e) In the Low Calculation Limit entry field, enter the
temperature where you want to start the calculation of
the derivative for the plot.

(f) In the High Calculation Limit entry field, enter the
temperature where you want to end the calculation of the
derivative for the plot.
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Set up other recalculations and normalisation

12. Setup dialog | Reports tab
(a) Select the Calculations tab to enter the calculation

parameters.
(b) Check Calculation and enter or select an equation in the

field to perform a calculation.
(c) Check Correction and enter the Correction Temperature

to perform a Thermal Expansion Correction.
(d) Check Normalize and enter the temperature at which

you would like the data to be normalized in the field.

Set up reporting and printing requirements

13. Setup dialog | Reports tab
(a) Select the Reports tab.
(b) Enter your name in the Name entry field.
(c) Enter a comment relating to your experiment in the

Comment entry field.
(d) Set up your report style by selecting the appropriate

radio buttons in the Options group.
For example, select the ‘Auto Print’ checkbox to obtain a
printout of your report automatically.
Select the ‘Parameters’ checkbox to include your
method parameters in the report.
Select the ‘Graph’ checkbox to include graphics in the
generated report.

✒ Note If ‘Auto Print’ is selected, then the system will send the report
information to the specified printer as well as the Report area.
However, if ‘Auto Print’ is not selected, the report will only be sent
to the Report area and can be viewed by selecting Report in the
View menu.

(e) Select the Autoconvert option you require. If you select
‘ASCII’ or ‘ASCII with Log’, then at the end of the data
collection the system will automatically generate a report
and store the data both in the Cary format as well as
ASCII XY pairs format in the current folder.

Set up storage of collected data

14. Setup dialog | Auto Store tab
(a) Select the Auto Store tab.
(b) Select ‘Storage Off’.



Cary WinUV

4-97

Set up visual system monitoring

15. Select the ‘Show Status Display’ checkbox to display various
information fields on your current reaction.

Finish setup

16. Once you are satisfied with your method setup, click “OK” to
save any changes made and close the Setup dialog. The
Cary will start to drive the temperature to the Start
temperature.

Zero the instrument

17. To Zero the instrument:
(a) Press the “Zero” button to zero the system. Alternatively,

select Zero in the Commands menu to perform a zero. A
Loading Guide dialog box is displayed.

(b) Place a blank solution in the cell that is in the light beam
in sample compartment and click “OK”. The system will
perform an instrument zero on the blank solution.

Equilibrate the sample

18. Make sure that the Cary has reached the Start temperature
and has been at this temperature for 2–3 minutes. If you enter
a hold time in the Stage 1 Hold field, the system will wait and
equilibrate at this temperature for the hold time before
proceeding with the ramp. It is not necessary to wait to press
the “Start” button.

Start the Thermal run

19. To start the Thermal run:
(a) Push the application “Start” button to start a data

collection. Alternatively, you can select Start in the
Commands menu. The system will display a Loading
Guide dialog box.

(b) Load your sample into the front cell holder.
(c) Enter the name of your sample in the text entry field then

press “OK”. The Cary will wait for the specified Hold time
and then perform the Thermal run.

Cary actions after the run

20. At the end of the run, depending on what you have set in
previous steps, the User Data Form may appear. If it does,
then fill-in the appropriate entries in the columns provided for
the sample and press “OK”. The calculation equation will
appear in the report.
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Also, as Autocalculate (Derivative group) was selected on the
Analyze tab of the Setup dialog box, a derivative calculation
will be performed at the end of the data collection.

The sample under investigation, with corresponding Tm
values, will appear in the Report area as well as parameters
used to generate the selected data file, Temperature profile,
and the method used to contain the Tm value.

A plot will appear in the Graphics area indicating the original
temperature data as well as a plot of the first derivative of the
selected scan. The point at which the derivative plot peaks
(i.e. maximum or minimum gradient on the original plot) is
reported as the Tm value and the original plot is marked with
an arrow to indicate this point.

To view a plot of the collected data, from the View menu
select the Graph option.

Save your data

21. To save your data:
(a) Click on the File menu item and select Save Data As…
(b) Click in the Files of Type field and select Batch.
(c) Enter the file name for this Thermal run in the File name

field.
(d) Click “Save”.
The data will be stored as a Batch file.

4.12.2 How to perform a run and determine Tm
using Hyperchromicity calculations

This demonstrates how to perform a Thermal run with multiple
temperature ramps and determine Tm using a hyperchromicity
calculation.

Start the Thermal application

1. On the Windows Taskbar click “Start” to display the Start
menu.

2. Move the cursor over the Programs menu item to display the
Programs menu.

3. Select Thermal in the Cary WinUV menu.
4. Select your instrument type (if necessary) and press “OK” to

open the Thermal application.
(Alternatively, you can double click on the Thermal icon in the
Cary WinUV folder on the desktop.)
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✒ Note If you are running a GLP system, you may be prompted to enter a
password before accessing the Thermal application.

Set up the data collection parameters

5. Setup dialog
Click the “Setup…” button or select Setup from the Menu line
to display the Setup dialog and specify the method
parameters for a new method.

To do this:

Set up instrument parameters such as wavelength, spectral
bandwidth etc.

6. Setup dialog | Cary tab
(a) Select the Cary tab and specify the instrument

parameters for your analysis.
(b) In the Wavelength field enter the wavelength that you

want monitored.
(c) In the SBW field enter the required spectral bandwidth.
(d) In the Ave Time field, enter the required value.

✒ Note For slow changes in temperature (i.e. slow ramp rates) it is
recommended that a long Ave Time (e.g. 2–3 seconds) be set.

(e) Enter the minimum and maximum graph ordinate values
in the Y Min and Y Max fields respectively.

Set up the collect temperature parameters

7. Setup dialog | Cary tab
(a) In the Start °C entry field, enter the temperature at which

you want to commence the data collection.

✒ Note Once you press “OK” to dismiss the Setup dialog, the Cary will
drive the temperature to the specified Start Temperature.

(b) In the Return °C entry field, enter the temperature that
you want the Temperature Controller to drive to at the
end of the data collection.

(c) Select the Monitor that the Cary will use to record the
temperature for each data point during the run.

(d) Select the ‘Advanced Collect’ radio button.
(e) Enter the number of changes in temperature rate that

you require in the Number of Stages field.

✒ Note An increase or decrease in the temperature must be a separate
stage.
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(f) Enter the Data Interval, ramp Rate, End temperature and
Hold temperature you require for each stage in the ramp
table. Select the stages where you want to collect data in
the Collect Data colulmn.

Set up the lamp source operation and the data display options

8. Setup dialog | Options tab
(a) Select the Options tab to specify the source conditions

and data display options for your analysis.
(b) Tick the ‘Auto Lamps Off’ checkbox if you want to

automatically turn off the lamps at the end of a collect.
This option enables a user to preserve the lifetime of the
lamps. It is especially useful for when performing
Thermal data collections overnight or unattended for
long periods of time.

(c) Click on the ‘UV/Vis’ radio button if you want both the
lamps on during the run.

(d) In the Display Options group, select the way in which
you want the data displayed as it is collected. Choose
the ‘Individual Data’ radio button to display the collected
data of each sample in individual graph boxes. Choose
the ‘Overlay Data’ radio button to superimpose the
collected data of each sample in the Thermal run in one
graph box.

Set up the Multicell Holder accessory

9. Setup dialog | Accessories tab
(a) Select the Accessories tab.
(b) Ensure that you have the Thermostattable 6 x 6 Multicell

Holder accessory installed prior to commencing the run.
(c) Select the ‘Use Cell Changer’ checkbox to enable the

accessory.
(d) Choose the ‘Select Cells’ radio button and select the

cells you require from the available cells in the Use Cells
group.

(e) Check the ‘Multi Zero’ checkbox to turn on the Multi Zero
facility.

(f) In this example, deselect Blank Correction.

Set up temperature display

10. Setup dialog | Accessories tab
In the Temperature Display group, select ‘Block’ and ‘Probe 1’
to turn on monitoring of the Multicell Holder block and one
temperature probe in the Status Display window.
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Set up the RBA accessory

11. Setup dialog | Accessories tab
(a) In the RBA group, tick the ‘Use RBA’ checkbox.
(b) Select either Attenuation and enter the Abs value or

select Position and enter the angle position.

Set up the analysis to reduce measurement interference

12. Setup dialog | Analyze tab
Select the Analyze tab and select ‘Smoothing’. Nominate the
smoothing Interval and Filter Size to control the number of
measurement points to be averaged.

Set up your method of analysis

13. Setup dialog | Analyze tab
(a) Select the Analyze tab.
(b) Check the ‘Hyperchromicity’ option to calculate the

temperature at which 50% of the DNA strands have
separated (Tm).

✒ Note The hyperchromicity calculation is performed once the run is
completed.

(a) Check ‘Van't Hoff Calculation’ to calculate a Van't Hoff
plot (Ln(K(T)) vs 1000/T(deg K)) and activate the
Hyperchromicity group.

(b) Select the ‘Self Complementary’ radio button if the DNA
molecule being analyzed consists of identical strands.
Otherwise select ’Non Self Complementary’.

(c) Enter the concentration in the Total Conc of Strands
entry field.

(d) Enter the Molecularity (i.e. the number of strands) of the
hybrid. For example, enter '2' in this field if the DNA
molecule being analyzed consists of two strands.

(e) Check the ‘Delta G’ checkbox to perform Delta G (free
energy) and K (equilibrium constant) calculations.

(f) In the Number of Temperatures field that is now
accessible, specify the number of temperatures at which
you would like to perform the Delta G and K calculations.
The number set here is reflected in the Temperature
table below this field.

(g) Enter the required temperature in each cell in the
Temperature table.
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Set up other recalculations and normalizations

14. Setup dialog | Calculations tab
(a) Select the Calculations tab.
(b) Check Calculation and enter or select an equation in the

field to perform a calculation.
(c) Check Correction and enter the required Correction

Temperature to perform a Thermal Expansion
Correction.

(d) Check Normalize and enter the temperature at which
you would like the data to be normalized in the field.

Set up your reporting and printing requirements

15. Select the Reports tab and specify your reporting
requirements.
(a) Enter your name in the Name entry field.
(b) Enter a comment relating to your experiment in the

Comment entry field.
(c) Set up your report style by selecting the appropriate

radio buttons in the Options group.
For example, select the ‘Auto Print’ checkbox to obtain a
printout of your report automatically.
Select the ‘Parameters’ checkbox to include your
method parameters in the report.
Select the ‘Graph’ checkbox to include graphics in the
generated report.

✒ Note If ‘Auto Print’ is selected, then the system will send the report
information to the specified printer as well as the Report area.
However, if ‘Auto Print’ is not selected, the report will only be sent
to the Report area and can be viewed by selecting Report in the
View menu.

(d) Select the Autoconvert option you require. If you select
‘ASCII’ or ‘ASCII with Log’, then at the end of the data
collection the system will automatically generate a report
and store the data both in the Cary format as well as
ASCII XY pairs format in the current folder.

Set up storage of collected data

16. Setup dialog | Auto Store tab
(a) Select the Auto Store tab to set up whether the collected

data is to be saved, and if so, when the Cary should
store the information.

(b) Select ‘Storage On (Prompt at End)’.



Cary WinUV

4-103

Set up visual system monitoring

17. Select the ‘Show Status Display’ checkbox to display various
information fields on your current reaction.

Finish setup

18. Once you are satisfied with your method setup click “OK” to
save any changes made and close the Setup dialog.

Zero the instrument

19. To Zero the instrument:
(a) Press the “Zero” button to zero the system. Alternatively,

select Zero in the Commands menu to perform a zero.
The system will display a Cell Loading Guide dialog box.

(b) Place the blank solutions in the correct positions in the
holder then press the “OK” button to zero the specified
cells.

Equilibrate the Samples

20. Make sure that the Cary has reached the Start temperature
and has been at this temperature for 2–3 minutes. If you enter
a hold time in the Stage 1 Hold field, the system will wait and
equilibrate at this temperature for the hold time before
proceeding with the ramp and it is not necessary to wait to
press the “Start” button.

Start the Thermal run

21. To start the Thermal run, click the “Start” button or select Start
in the Commands menu.
The Save As dialog will appear.

Set up file name and trace names for the data

22. To set up file and trace names:
(a) Enter the appropriate name for your Thermal run and

click “Save”. The system will now display a Cell Loading
Guide dialog box.

(b) Place the solutions in the correct cell positions in the
holder.

(c) Enter the name of each sample in the corresponding text
entry field then click “OK”.
The Cary will wait for the specified Hold time and then
perform the Thermal run.
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Cary prompts after the run

23. At the end of the run, depending on what you have set in
previous steps, the User Data Form may appear. If it does,
then fill in the appropriate entries in the columns provided for
each sample trace and click “OK”. The calculation equation
will appear in the report.

Hyperchromicity calculations

24. The Cary will now prompt you to use the Thermal ruler to
define various limits for the hyperchromicity calculations.
(a) A prompt will appear asking you to select the Associated

DNA limits using the Ruler. Press the “OK” button on this
prompt. The cursor changes to ruler mode.

(b) Place your mouse on the Thermal curve at one end of
the linear region of the Associated DNA part of the curve
(prior to transition). Click and hold down the left mouse
button, then drag the mouse along the curve and release
the left mouse button at the other end of the linear
region.
The software will automatically calculate a linear least
squares line between the selected points and
extrapolate to both ends of the melting curve.

(c) An Associated DNA Limits dialog will appear displaying
the upper and lower limits that you selected with the
Thermal Ruler. Press the “OK” button to accept the
calculated line.

(d) A prompt will then appear asking you to select the
Deassociated DNA limits using the Ruler. Press the “OK”
button on this prompt. The cursor changes to ruler
mode.

(e) Place your mouse on the Thermal curve at one end of
the linear region of the Deassociated DNA part of the
curve (after the transition). Click and hold down the left
mouse button, then drag the mouse along the curve and
release the left mouse button at the other end of the
linear region.
The software will automatically calculate a linear least
squares line between the selected points and
extrapolate to both ends of the melting curve.

(f) A Deassociated DNA Limits dialog will appear displaying
the upper and lower limits that you selected with the
ruler. Press the “OK“ button to accept the calculated line.
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✒ Note The Associated and Deassociated DNA Limits dialogs allow you to
re-select your limits if you are not satisfied with the linear least
squares lines drawn in the graph box. To do this, click the “Retry”
button on either dialog and select another region. If you wish to exit
from the calculation mode, click “Cancel”. The ruler trace is
removed from the graph.

The Linear Region Associated and Deassociated
correction points are displayed in the Report area.

✒ Note If the two extrapolated lines cross at any point, a warning will
appear. Click “Cancel” and repeat steps (a) to (f) above and
re-select the linear regions. Click “Ignore” to proceed with the
calculation using the regions you have selected.

Using the lines calculated in the previous steps the
software will automatically create a second graph box
and display the calculated Alpha curve.

(g) A prompt will appear asking you to select the range on
the Alpha curve that will be used for the Tm calculation.
Press the “OK” button to make your selection.

(h) Place your mouse on the alpha curve at one end of the
linear region. Click and hold down the left mouse button,
then drag the mouse along the curve and release the left
mouse button at the other end of the linear region.

(i) An Alpha Tm Limits dialog box will appear displaying the
selected limits. Click the “Retry” button to re-select the
limits if required. Press the “OK” button to accept the
selected ranges. A linear least squares line is drawn
between the selected points and the value of
temperature where α = 0.5 is calculated to give the Tm
value. (The Tm value is automatically reported in °C and
K.)

If you have chosen the Van't Hoff Calculation
method to calculate Delta G and K:

(a) Using the data calculated in step (i) above, the system
automatically creates a third graph box displaying a
Van't Hoff plot. A prompt will appear asking you to select
the required range on the Van't Hoff plot to calculate
Delta G and K. Press the “OK” button on this dialog.

(b) Place your mouse on the Van't Hoff curve at one end of
the linear region. Click and hold down the left mouse
button, then drag the mouse along the curve and release
the left mouse button at the other end of the linear
region.
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(c) A Van't Hoff Limits dialog box will also appear displaying
the upper and lower limits that you selected with the
ruler. Press the “OK” button to accept the calculated line.
Alternatively, you can select the “Retry” button to re-
select the limits using the ruler.

✒ Note If there is an error in the Van't Hoff calculation you will be prompted
to re-select the linear region.

A linear least squares line is calculated between these
points and is extrapolated to both ends of the Van't Hoff
plot. The slope and intercept of the calculated line gives
the enthalpy and entropy of the hybrid formation (Delta
H° and Delta S° respectively).

The software will automatically send the results, using the
calculated alpha curve, to the Report area including:

❑ K(Tm)experimental

❑ K(Tm)from first principles

❑ K(Tm)experimental/K(Tm)from first principles

25. Step 24 will be repeated for each sample trace measured.
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5 Troubleshooting

If you are having problems with your Cary system, check the
following information to see if there is a solution to your problem:

Installation and startup problems

1. Check the troubleshooting section in the Hardware manual
supplied with the instrument.

2. Check the information provided below.

Software problems

1. First check the information below.

2. Check the troubleshooting information provided in the on-line
Help. To do this, select the Windows “Start” button, then
Programs, Cary WinUV, Cary Help. Select Troubleshooting
and follow the links from there.

3. Check the Late Breaking news sheets that were shipped with
the Cary WinUV CDROMs.

4. If you still have not found the solution to your problem then you
can email a question to: uv@osi.varian.com. Alternatively, you
can contact your local Varian office or representative..

5.1 Instrument offline
Problem

When I start the Cary WinUV software the application reports that
the instrument is “Offline”.

Solution

Check the connection of the main instrument cable attaching the
PC to the instrument.

Ensure that the instrument has completed its initialization tests
before you start the Cary software.

Refer to chapter 4 in the Hardware manual provided with the
instrument for more information.
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5.2 Connect button instead of Start
Problem

When I start the WinUV application I want to use the Start button
has changed to a Connect button, why?

Solution

When you first start the WinUV software the System Information
application has control of the instrument while it initializes. Until the
initialization has finished any other application that you start will not
have control of the instrument, hence the ‘Connect’ button. Just
wait until the Connect button changes to Start. If it does not change
then check to see if you have any other Cary applications running.
If they are not collecting data you can just press the Connect
button to get control of the instrument.

5.3 Not enough memory
Problem

After installing version 2 of the Cary WinUV software I get an error
saying that there is not enough memory and the Cary WinUV
software will not run.

Answer

Check that you have version 4.0 or later of Microsoft’s Internet
Explorer (IE4) installed (to check the version start Internet Explorer
and select About Internet Explorer from the Help menu. The
version number will be displayed).

5.4 Poor display of videos and photographs
Problem

The graphics and video display appears fuzzy, grainy or weird
colors.

Solution

Increase your display settings to a higher resolution as follows:

1. Select “Start”, Settings, Control Panel, Display.

2. Select the Settings tab and adjust the Color palette to a higher
screen resolution (i.e. 16 bit or 32 bit color) providing your
monitor and display adapter allow it.
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3. Press “OK”.

✒ Note You may have to restart your PC for the settings to take effect.

5.5 GLP log does not list some privilege changes
Problem

I have changed multiple privileges using the GLP application but
not all of them appear in the log file that the application creates,
what has happened?

Answer

You need to press the Apply changes now button on the Privileges
tab each time you change privileges for a user or application. You
cannot make multiple changes and then press the Apply Changes
now button – the changes are actually made but they don’t appear
in the log.

5.6 Report header and footer not being updated
Problem

I have changed the report header and footer information in the
System Information application but it is not being updated when I
generate a report, why?

Answer

If you running under Windows NT you need to be logged on as an
Administrator to make the changes in System Information.
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